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About this guide

This chapter covers the following topics:

®  What this guide covers (page 10)
¢ Conventions (page 11)
¢ About the BD LSRFortessa X-20 documentation (page 11)

e Instrument technical support (page 13)
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What this guide covers

This guide describes the procedures necessary to operate and
maintain your special order BD LSRFortessa™ X-20 cell analyzer.
Because many cytometer functions are controlled by

BD FACSDiva™ software, this guide also contains information
about software features required for basic cytometer setup and
operation.

This guide assumes you have a working knowledge of basic
Microsoft® Windows® operation. If you are not familiar with the
Windows operating system, see the documentation provided with
your computer.
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Conventions

Introduction The following table lists the safety symbols used in this guide to
alert you to potential hazards.

Safety symbols

Symbol | Meaning

Caution alert

Identifies a hazard or unsafe practice that could result in
data loss, material damage, minor injury, severe injury, or

death

Biological hazard

Electrical hazard

Laser hazard

> BB P

About the BD LSRFortessa X-20 documentation

Introduction This topic describes the documentation available with the special
order BD LSRFortessa X-20 cell analyzer.

Publication formats This guide is provided in PDF format to provide an eco-friendly
option. All content is also included in the BD FACSDiva software
Help.
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Help system

The help system installed with BD FACSDiva software includes all
content from this guide and the documents listed below. Access the
BD LSRFortessa X-20 help system from the Help menu in

BD FACSDiva software. Internet access is not required to use the
help system.

The help system is compiled from the following documents:

BD FACSDiva Software Reference Manual: Includes
instructions or descriptions for installation and setup,
workspace components, acquisition controls, analysis tools,
and data management. Access this manual from the

BD FACSDiva Software Help menu (Help > Documentation >
Reference Manual), or by double-clicking the shortcut on the
desktop.

BD Cytometer Setup and Tracking Application Guide:
Describes how to use the BD® Cytometer Setup and Tracking
(CS&T) features in BD FACSDiva software.

BD LSRFortessa X-20 Cell Analyzer Site Preparation Guide:
Contains specifications for:

- Cytometer weight and size
— Temperature and other environmental requirements
— Electrical requirements

BD High Throughput Sampler User’s Guide: Describes how to
set up and operate the BD™ High Throughput Sampler (HTS)
option. It also contains a description of BD FACSDiva
software features specific to the HTS.

BD FACSFlow Supply System User’s Guide: Describes the
optional automated sheath and waste fluid control system
designed for use with the BD® LSR II, BD LSRFortessa™, and
BD LSRFortessa X-20.
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Instrument technical support

Introduction

Contacting
technical support

This topic describes how to get technical assistance.

If technical assistance is required, contact your local
BD Biosciences customer support representative or supplier.

When contacting BD Biosciences, have the following information
available:

Product name, part number, and serial number
Version of BD FACSDiva software you are using
Any error messages

Details of recent system performance

To contact customer support:

1.
2.
3.

Go to bdbiosciences.com.
Select your region. You see information in your local language.
Click Go.

Click the Support link for details for your local region.



http://www.bdbiosciences.com
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Introduction

This chapter covers the following topics:

¢ Instrument overview (page 16)

e Components (page 17)

¢ Fluidics (page 19)

e Sheath and waste containers (page 23)
e  Optics (page 23)

e  Workstation (page 27)
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Instrument overview

The special order BD LSRFortessa X-20 cell analyzer is an air-
cooled multi-laser benchtop flow cytometer with the ability to
acquire parameters for a large number of colors. It uses
fixed-alignment lasers that transmit light through a flow cell to
configurable polygon detector arrays. These detectors collect and
translate the resulting fluorescence signals into electronic signals.
Cytometer electronics convert these signals into digital data.
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Components

Introduction This topic describes the instrument’s components.
Instrument

overview

/ Heat ventilation slots

& BD LSRFortessa

Special Order Research Product

Power switch (right side)

Sample injection port (SIP)

Side drawer (polygon Control panel
detector arrays)

i Caution! Do not place any objects on top of the

instrument. Blocking the ventilation may cause the
instrument to overheat.
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the instrument. Any spill of liquid into the ventilation

f Caution: Electrical Hazard! Do not place liquids on top of
openings could cause electrical shock or damage to the

instrument.
Power switch The power switch is located on the right side of the instrument.
Control panel The control panel contains the following fluidics controls:

e Sample flow rate control buttons
¢ Fluid control buttons
e Sample fine adjust knob

The control panel contains the following system indicators:

* Acquisition status

e System power

SAMPLE

ACQUISITION STATUS
FINE ADJ RUN STANDBY PRIME Low o

= — [

@ Biid 8a6 ==
I
| | | | | |

Fluid control buttons Sample flow rate control buttons System indicators

More information e  Fluidics (page 19)

*  Optics (page 23)




Fluidics
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Introduction

Purpose

Sample flow rate
control

This topic describes the fluidics system.

The purpose of the fluidics system is to carry the sample out of the
sample tube and into the sensing region of the flow cell. Cells are
carried in the sample core stream in single file and measured
individually.

Three flow rate control buttons (LOW, MED, and HIGH) set the
sample flow rate through the flow cell. The SAMPLE FINE AD]
knob allows you to adjust the rate to intermediate levels.

When the SAMPLE FINE AD]J knob is at its midpoint, the sample
flow rates at the LOW, MED, and HIGH settings are
approximately 12, 35, and 60 pL/min of sample, respectively. The
knob turns five full revolutions in either direction from its
midpoint, providing sample flow rates from 0.5-2X the midpoint
value. For example, if the LOW button is pressed, the knob will
give flow rates from approximately 6-24 pL/min.
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Fluid control

System indicators

Three fluid control buttons (RUN, STANDBY, and PRIME) set the
cytometer mode.

RUN. Pressurizes the sample tube to transport the sample
through the sample injection tube and into the flow cell.

The RUN button is green when the sample tube is on and the

support arm is centered. When the tube support arm is moved
left or right to remove a sample tube, the cytometer switches to
an automatic standby status to conserve sheath fluid, and the

RUN button changes to orange.

STANDBY. Stops fluid flow to conserve sheath fluid.

When you leave the cytometer for more than a few minutes,
place a tube containing 1 mL of deionized (DI) water on the
sample injection port (SIP) and press STANDBY.

PRIME. Prepares the fluidics system by draining and filling the
flow cell with sheath fluid.

The fluid flow initially stops and pressure is reversed to force
fluid out of the flow cell and into the waste container. After a
preset time, the flow cell fills with sheath fluid at a controlled
rate to prevent bubble formation or entrapment. At
completion, the cytometer switches to standby mode.

The two system indicators (ACQUISITION STATUS and SYSTEM
POWER) show the current status of the cytometer.

ACQUISITION STATUS. The light is green when the sample
is being acquired by the cytometer.

SYSTEM POWER. The light is blue when the cytometer
power is on.



Sample injection
port
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The SIP is where the sample tube is installed. The SIP includes the
sample injection tube and the tube support arm. Samples are
introduced through a stainless steel injection tube equipped with
an outer droplet containment sleeve. The sleeve works in
conjunction with a vacuum pump to eliminate droplet formation
of sheath fluid as it backflushes from the sample injection tube.

Outer sleeve

Sample injection tube

Tube support arm

Sample injection tube. Stainless steel tube that carries sample from
the sample tube to the flow cell. This tube is covered with an outer
sleeve that serves as part of the droplet containment system.

Tube support arm. Arm that supports the sample tube and
activates the droplet containment system vacuum. The vacuum is
on when the arm is positioned to the side and off when the arm is
centered.

Note: If a sample tube is left on the SIP with the tube support arm
to the side (vacuum on), the sample will be aspirated into the waste
container.
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Cautions when
using the HTS
option

Droplet
containment
module

A\

A\

>

Caution: Biohazard! When using the BD LSRFortessa
X-20 cell analyzer with the HTS, ensure that the HTS is
completely pushed into the operating position before
removing the droplet containment module (DCM) sleeve
or disconnecting the sample coupler from the SIP. This is
to avoid accidental leakage of potentially biohazardous
liquids directly onto the instrument. With the HTS in the
proper location, the containment dish with padding is
directly below the SIP.

Caution! If you are using the HTS option, always slide
the HTS mount slowly to prevent sample cross-
contamination when the wells are full. Never move the
HTS when it is in operation.

Caution! Do not lean on or put any weight on the HTS as
it could damage the instrument.

The DCM prevents sheath fluid from dripping from the SIP and
provides biohazard protection.

When no sample tube is installed on the SIP, sheath fluid
backflushes through the sample injection tube. This backflush
helps prevent carryover of cells between samples. The DCM
vacuum is activated when the sample tube is removed and the tube
support arm is moved to the side. Sheath fluid is aspirated as it
backflushes the sample injection tube.
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Sheath and waste containers

Introduction This topic describes the sheath and waste containers. The sheath
and waste containers are outside the cytometer and are positioned
on the floor.

Note: If your system is using the BD FACSFlow™ supply system,
please see the documentation provided with your system.

Sheath container ~ The sheath container has a capacity of 8 L. Sheath fluid is filtered
through an in-line, interchangeable filter that prevents small
particles from entering the sheath fluid lines.

capacity (8 L). When an overfull tank is pressurized,
erratic cytometer performance can result.

t Caution! Do not fill the sheath tank to its maximum

Waste container The waste container has a capacity of 10 L. An alarm sounds when
the container becomes full.

More information e  Preparing the sheath container (page 31)

e DPreparing the waste container (page 36)

Optics

Introduction This topic describes the optical components for the special order
BD LSRFortessa X-20 cell analyzer including:

¢ Detector arrays
e Laser options
e Optical filters

e Signal detectors
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Detector arrays The BD LSRFortessa X-20 detector arrays consist of polygons.
Each polygon can be outfitted with two to eight PMTs and can
detect up to eight signals.

——

©BD LSRFortessa
‘Special Order Research Product

Locked cover (lasers
accessible by BD Service only)

Side drawer with polygons

Laser options The special order BD LSRFortessa X-20 cell analyzer can be
configured with up to five lasers as listed in the following table.
The cytometer can also be configured with up to five lasers from a
variety of wavelengths and powers through our special order
research program.

Laser Wavelength (nm) Power (mW)
Blue 488 50
Red 640 40
Violet 405 50
NUV 375 50
Yellow-green 561 50




Optical filters
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Optical filters attenuate light or help direct it to the appropriate
detectors. The name and spectral characteristics of each filter
appear on its holder.

There are two types of optical filters in the BD LSRFortessa X-20:

e Longpass dichroic filters (LPs). Transmit wavelengths that are
longer than the specified value and reflect all light below the
specified wavelength.

¢ Bandpass filters (BPs). Pass a narrow spectral band of light.

When dichroic filters are used as steering optics to direct different
color light signals to different detectors, they are called dichroic
mirrors. LP dichroic mirrors transmit longer wavelengths to one
detector while reflecting shorter wavelengths to a different
detector.

The BD LSRFortessa X-20 cell analyzer polygon detector arrays
use dichroic longpass mirrors on the inside, and bandpass filters on
the outside of the filter holders. You can customize the arrays with
other wavelengths of filters and mirrors.

Bandpass filters
Longpass dichroic mirrors
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Signal detectors

More information

Light signals are generated as particles pass through the laser beam
in a fluid stream. When these optical signals reach a detector,
electrical pulses are created that are then processed by the
electronics system.

There are two types of signal detectors in the BD LSRFortessa
X-20 cell analyzer:

¢ Photomultiplier tubes (PMTs). Used to detect the weaker
signals generated by side scatter and all fluorescence channels.
These signals are amplified by applying a voltage to the PMTs.

¢ Photodiodes. Less sensitive to light signals than the PMTs. A
photodiode is used to detect the stronger forward scatter (FSC)
signal. However, an optional PMT for detecting FSC is
available through the BD special order research program.

e Optical filter theory (page 104)
¢ About the base configuration (page 133)

® Special order configurations (page 150)
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Workstation

Introduction This topic describes the components of the BD LSRFortessa X-20
workstation.

Workstation Acquisition, analysis, and most instrument functions are controlled

components by the BD LSRFortessa X-20 workstation. It includes a PC, one or

two monitors, and a printer.
Your workstation is equipped with the following:

*  Microsoft Windows operating system

e BD FACSDiva software version 7.0 or later for data
acquisition and analysis

¢ Software documentation including the help system

More information ¢  About the BD LSRFortessa X-20 documentation (page 11)
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Cytometer setup

This chapter covers the following topics:

e  Starting the cytometer and computer (page 30)
e Preparing the sheath container (page 31)

¢ Removing air bubbles (page 33)

e DPreparing the waste container (page 36)

¢ Priming the fluidics (page 39)

e About the optical filters and mirrors (page 40)
e Changing optical filters and mirrors (page 42)

e Custom configurations and baselines (page 43)
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Starting the cytometer and computer

Introduction

Procedure

This topic describes how to start the cytometer and turn on the
computer.

Note: If your system is using the BD FACSFlow supply system,
make sure that the BD FACSFlow supply system is powered on
before the cytometer.

To start the cytometer:
1. Turn on the power to the flow cytometer.

2. Allow 30 minutes for the optical system temperature to
stabilize.

f Caution! Failure to warm up and stabilize the

instrument could affect sample data.

3. Turn on the computer and log in to Windows.

Note: You can turn on the power to the flow cytometer and
the workstation in any order.

4. Start BD FACSDiva software by double-clicking the shortcut
on the desktop, and log in to the software.

5. Check the Cytometer window in BD FACSDiva software to
ensure that the cytometer is connected to the workstation.

The cytometer connects automatically. While connecting, the
message Cytometer Connecting is displayed in the status area
of the Cytometer window. When connection completes, the
message changes to Cytometer Connected.
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Cytometer - LSRFortessa (1)

Tirme: Event

—
Cytometer Cnmeu.eD

If the message Cytometer Disconnected appears, see
Electronics troubleshooting (page 127).

Preparing the sheath container

Introduction This topic describes how to prepare the sheath container.

Note: If your system is using the BD FACSFlow supply system,
please see the documentation provided with your system.

When to check the  Check the fluid levels in the sheath container every time you use
sheath container the cytometer. This ensures that you do not run out of sheath fluid
during an experiment.
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Sheath container
components

Clamp knob

Cap handle Air line (green)

Tank handle

Vent valve

Sheath fluid line (blue)
to cytometer

Filter assembly

Procedure To prepare the sheath container:

1. Verify that the flow cytometer is in standby mode.
Press the STANDBY button on the control panel if necessary.
2. Disconnect the green air line from the sheath container.

3. Depressurize the sheath container by pulling up on the vent
valve.

4. Remove the sheath container lid.

Unscrew the clamp knob and push down to loosen, if
necessary. Tilt the cap to the side to remove it from the tank.



More information
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5. Add 6 L of sheath fluid, such as BD FACSFlow solution, to the
sheath container.

capacity (8 L). When an overfull tank is pressurized,
erratic cytometer performance can result.

2 Caution! Do not fill the sheath tank to its maximum

6. Replace the sheath container lid.
7. Reconnect the green air line.

8. Make sure the gasket on the inside lip of the sheath lid is
seated correctly and has not slipped out of position.

If the gasket is not seated correctly, the tank will not pressurize
properly.

9. Close the sheath lid and tighten the clamp knob to finger-tight.
Ensure that the blue sheath fluid line is not kinked.

Removing air bubbles (page 33)
e Changing the sheath filter (page 56)

Removing air bubbles

Introduction

This topic describes how to remove trapped air bubbles in the
sheath filter and the sheath line. Air bubbles can occasionally
dislodge and pass through the flow cell, resulting in inaccurate
data.
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Procedure To remove air bubbles:
1. Check the sheath filter for trapped air bubbles.

Cytometer fluid line
(roller clamp not visible)

Vent fitting

Vent line

2. [If bubbles are visible, gently tap the filter body with your
fingers to dislodge the bubbles and force them to the top.

vigorously shake, bend, or rattle the sheath filter or

2 Caution! When removing air bubbles, do not
you might damage it.
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3. Direct the vent line into a beaker and press the small button at
the end of the vent fitting against the side of the beaker until a
steady stream of fluid empties from the filter.

Button

Vent fitting

4. Tilt the filter and verify that no trapped air remains in the
filter.

5. Repeat steps 3 and 4 until no air is observed in the filter.

6. Check the sheath line for air bubbles.

7. Open the roller clamp at the fluidics interconnect (if necessary)
to bleed off any air in the line. Collect any excess fluid in a
waste container.

8. Close the roller clamp.
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Preparing the waste container

Introduction This topic describes how to prepare the waste container.

Note: If your system is using the BD FACSFlow supply system,
please see the documentation provided with your system.

Caution: Biohazard! All biological specimens and

@ materials coming into contact with them are considered
biohazardous. Handle as if capable of transmitting
disease. Dispose of waste using proper precautions and in
accordance with local regulations. Never pipette by
mouth. Wear suitable protective clothing, eyewear, and
gloves.

When to check the  Check the fluid levels in the waste container every time you use the
waste container cytometer. This ensures that the waste container does not become
too full.
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Waste container

components
Waste tubing (orange) from
cytometer
Waste air vent filter
| level sensor line
Bracket
Cautions

waste, put the cytometer in standby mode before
disconnecting the waste container.

f Caution: Biohazard! To avoid leakage of biohazardous

Caution: Biohazard! The waste container contents might
be biohazardous. Treat contents with bleach (10% of
total volume).
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Procedure

container cap assembly becomes clogged, air cannot be

t Caution! If the air vent filter on the top of the waste

vented from the container, causing it to swell under
pressure. If you observe swelling of the waste container,
loosen the cap to relieve the pressure, and immediately
replace the air filter. See Replacing the waste air filter
(page 595) for instructions. Removing the air filter or the
waste container cap assembly without first relieving the
pressure might generate an unnoticeable aerosol. Use
appropriate precautions when troubleshooting a clogged
air filter. Wear suitable protective clothing, eyewear, and
gloves.

To prepare the waste container:

1.

Verify that the flow cytometer is in standby mode.
Press the STANDBY button on the control panel if necessary.

Disconnect the orange waste tubing and the black level sensor
line from the waste container.

Keep the lid on the waste container until you are ready to
empty it.

Empty the waste container.
Caution! The waste container is heavy when full.

When emptying it, use good body mechanics to
prevent injury.

Add approximately 1 L of bleach to the waste container and
close it.

Reconnect the orange waste tubing and make sure it is not

kinked.

Reconnect the level sensor line.
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Priming the fluidics

Introduction

When to prime the
fluidics

Procedure

More information

This topic describes how to prime the fluidics system.

Sometimes, air bubbles and debris may become lodged in the flow
cell. This is indicated by excessive noise in the forward and side
scatter parameters (FSC and SSC, respectively). In these cases, it is
necessary to prime the fluidics system.

To prime the fluidics:

1. Move the tube support arm to the side.
2. Remove the tube from the SIP.

3. Press the PRIME fluid control button to force the fluid out of
the flow cell and into the waste container.

Once drained, the flow cell automatically fills with sheath fluid
at a controlled rate to prevent bubble formation or
entrapment. The STANDBY button turns amber after
completion.

4. Repeat the priming procedure, if necessary.

5. Install a 12 x 75-mm tube with 1 mL of DI water on the SIP
and place the support arm under the tube. Leave the cytometer
in standby mode.

e Cytometer troubleshooting (page 118)
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About the optical filters and mirrors

Introduction This topic provides a description of the optical filters and mirrors.

Filter and mirror Each PMT has an optic holder in front of it. The optic holders are

configurations labeled with numbers indicating the wavelengths of the bandpass
filter and longpass dichroic mirror they contain (for example, 695/
40 and 685 LP, respectively). The optic holder in front of the last
PMT in the detector array contains only a bandpass filter and is
marked accordingly.

PMT A

Optic holder
handle

Optic holders <

The filters steer progressively shorter wavelengths of light to the
next PMT in the array as indicated by the lines and arrows on the
top of the polygon.



Optic holders,
filters, and mirrors

Base configurations

BD FACSDiva
cytometer
configuration

More information
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Optic holders house filters and mirrors. Your cytometer includes
several blank (empty) optic holders.

Caution! To ensure data integrity, do not leave any slots
A empty in a detector array when you are using the
associated laser. Always use a blank optic holder.

Each BD LSRFortessa X-20 cell analyzer has a base cytometer
configuration that corresponds to the layout of the installed lasers
and optics in your cytometer. This base configuration is set by your
field service engineer.

Before you acquire data using BD FACSDiva software, you must
specify a cytometer configuration. The cytometer configuration
defines which filters and mirrors are installed at each detector.

BD FACSDiva software provides a BD base configuration for your
BD LSRFortessa X-20 cell analyzer. Select Cytometer >

View Configuration to create, modify, or delete custom cytometer
configurations. (See the Cytometer and Acquisition Controls
chapter of the BD FACSDiva Software Reference Manual for
details.)

¢ Changing optical filters and mirrors (page 42)
e About the base configuration (page 133)

e Special order configurations (page 150)
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Changing optical filters and mirrors

Introduction

Procedure

More information

This topic describes how to verify that the optical filters are in the
appropriate position for your particular requirements. Before you
run samples, you must set up the optical filters.

the BD LSRFortessa X-20 Safety and Limitations Guide

; Caution: Laser Hazard! Follow the precautions outlined in

while changing optical filters or mirrors.

To change a filter or mirror:

1.

Access the appropriate detector array.

Polygon detector arrays are located in the left side cytometer
drawer.

Remove the appropriate optic holder.

Replace the removed optic holder with the new holder
containing the appropriate filter and mirror set.

Verify that the filters are arranged so that the longest
wavelength is in the A position and the shortest wavelength is
in the last position used.

Close the cytometer side drawer.

Detector array configurations (page 129)
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Custom configurations and baselines

Introduction This topic describes where to find information on how to create a
custom configuration and define a baseline for a performance
check.

Overview BD Cytometer Setup and Tracking (CS&T) software is used to

define the baseline performance of your cytometer. A baseline
provides a starting point for the tracking of cytometer
performance. When running a performance check, you compare
the results to the baseline.

Some BP filters might not be normalized to CS&T settings. In this
case, CS&T will generate sensitivity and background values (Qr
and Br, respectively) that are not comparable from instrument to
instrument. They are however, still trackable on one cytometer. In
addition, you must carefully check the PMT voltages that CS&T
sets for these filters. See Optimizing cytometer settings (page 63).
Please see the latest published filter guides available on our website
(bdbiosciences.com) for more information.

See the BD Cytometer Setup and Tracking Application Guide for
information on creating custom configurations and defining a
baseline.

More information e Running a performance check (page 68)



http://www.bdbiosciences.com
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Maintenance

This chapter covers the following topics:

e Maintenance overview (page 46)

¢  Cleaning the fluidics (page 47)

e Shutting down the cytometer (page 49)

¢  Flushing the system (page 50)

*  Maintaining the waste management system (page 53)
* Replacing the waste air filter (page 56)

e Changing the sheath filter (page 57)

e Changing the Bal seal (page 59)

¢ Changing the sample tube O-ring (page 61)
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Maintenance overview

Introduction

General use
guidelines

This topic provides an overview of the special order
BD LSRFortessa X-20 cell analyzer routine maintenance and
cleaning procedures.

biological specimens and materials is considered
biohazardous.

i\ Caution: Biohazard! Coming into contact with all

Follow these guidelines whenever operating or maintaining the
cytometer:

e Handle all biological specimens and materials as if they are
capable of transmitting disease.

e Dispose of waste using proper precautions and in accordance
with local regulations.

¢ Never pipette by mouth.

e Wear suitable protective clothing, eyewear, and gloves.

For fluidics maintenance, we recommend the following cleaning
solutions: BP®

e BD® FACSClean solution

e 10% bleach solution

*  0.5% solution of sodium hypochlorite

Use DI water to dilute bleach and sodium hypochlorite to
appropriate concentrations.

Caution! Higher concentrations of sodium hypochlorite
A and use of other cleaning solutions might damage the
cytometer.




Chapter 4: Maintenance | 47

When to perform  Perform maintenance procedures in the following frequencies.
maintenance
procedures

Frequency Maintenance procedure

Daily e Cleaning the fluidics (page 47)
e Shutting down the cytometer (page 49)

Scheduled (every e Flushing the system (page 50)

two weeks) e Maintaining the waste management system

(page 53)

Periodic (frequency | e Changing the sheath filter (page 57)
depends on how
often you run the
cytometer)

e Changing the Bal seal (page 59)
e Changing the sample tube O-ring (page 61)

Cleaning the fluidics

Introduction This topic describes how to perform the daily fluidics cleaning.

Overview Cleaning the fluidics daily prevents the sample injection tube from
becoming clogged and removes dyes that can remain in the tubing.

In addition to daily cleaning, follow this procedure immediately
after running viscous samples or nucleic acid dyes such as Hoechst,
DAPI, propidium iodide (PI), acridine orange (AO), or thiazole
orange (TO).

Procedure To clean the fluidics:
1. Press RUN and HIGH on the cytometer fluid control panel.
2. [Install a tube containing 3 mL of a cleaning solution on the SIP

with the support arm to the side (vacuum on) and let it run for
1 minute.
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For the cleaning solution, use BD FACSClean solution. See
Maintenance overview (page 46) for other recommended
cleaning solutions.

3. Move the tube support arm under the tube (vacuum off) and
allow the cleaning solution to run for 5 minutes with the
sample flow rate set to HIGH.

4. Repeat steps 2 and 3 with DI water.

5. Repeat steps 2 and 3 with 1.5% dilution of BD Detergent
Solution Concentrate.

Note: The BD Detergent Solution Concentrate must be diluted
before use. Mix one full 15 mL bottle of BD Detergent
Solution Concentrate into 985 mL of DI water to make 1 L
total.

Caution! Do not mix BD Detergent Solution Concentrate
and bleach because they produce chlorine gas.

6. Repeat steps 2 and 3 with DI water.
7. Press the STANDBY button on the fluidics control panel.

8. Place a tube containing no more than 1 mL of DI water on the
SIP.

A tube with 1 mL of DI water should remain on the SIP to
prevent salt deposits from forming in the injection tube. This
tube also catches back drips from the flow cell.

the SIP. When the instrument is turned off or left in
standby mode, a small amount of fluid will drip back
into the sample tube. If there is too much fluid in the
tube, it could overflow and affect the cytometer
performance.

2 Caution! Do not leave more than 1 mL of water on




Chapter 4: Maintenance | 49

Shutting down the cytometer

Introduction This topic describes how to shut down the cytometer.

Before you begin  Each time you shut down the cytometer, perform the daily cleaning
as described in Cleaning the fluidics (page 47).

Procedure To shut down the cytometer:
1. Place a tube of DI water on the SIP.

2. Turn off the flow cytometer.
3. Select Start > Shutdown to turn off the computer (if needed).

4. TIf your system is using the BD FACSFlow supply system, shut
off the BD FACSFlow supply system.

If the cytometer will not be used for a week or longer, perform a
system flush and leave the fluidics system filled with DI water to
prevent saline crystals from clogging the fluidics.

More information ¢  Cleaning the fluidics (page 47)

¢  Flushing the system (page 50)
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Flushing the system

Introduction

Cautions

Procedure

This topic describes how to perform an overall fluidics cleaning to
remove debris and contaminants from the sheath tubing, waste
tubing, and flow cell. Perform the system flush at least every 2
weeks.

Note: If you are using the BD FACSFlow supply system, see the
BD FACSFlow Supply System User’s Guide for instructions on
flushing the system.

contaminated with biohazardous material. Use 10%

T Caution: Biohazard! The cytometer hardware might be
bleach to decontaminate the instrument.

To perform a system flush:

1. Remove the sheath filter.

a. Press the quick-disconnects on both sides of the filter
assembly.

b. Remove the filter assembly.

c. Connect the two fluid lines.

Caution! Do not run detergent, bleach, or ethanol

A through the sheath filter. They can break down the
filter paper within the filter body, causing particles to
escape into the sheath fluid, possibly clogging the
flow cell.

2. Empty the sheath container and rinse it with DI water.

3. Fill the sheath container with at least 1 L of undiluted
BD FACSClean solution.

4. Empty the waste container, if needed.

5. Open the roller clamp by the fluidics interconnect, and drain
the fluid into a beaker for 5 seconds.
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6. Remove the DI water tube from the SIP.
7. Prime the instrument twice:

a. Press the PRIME button on the fluidics control panel.

b. When the STANDBY button lights (amber), press the
PRIME button again.

8. Install a tube with 3 mL of undiluted BD FACSClean solution
on the SIP and put the tube support arm underneath the tube.

See Maintenance overview (page 46) for other recommended
cleaning solutions.

9. Press RUN and HIGH on the cytometer fluid control panel.
Run for 30 minutes.

10. Press the STANDBY fluid control button and depressurize the
sheath container by lifting the vent valve.

11. Empty the waste tank to avoid the mixing of Bleach and BD
Detergent Solution Concentrate.

12. Repeat steps 2 through 11 with DI water.

13. Repeat steps 2 through 11 with 1.5% dilution of BD Detergent
Solution Concentrate.

Note: The BD Detergent Solution Concentrate must be diluted
before use. Mix one full 15 mL bottle of BD Detergent
Solution Concentrate into 985 mL of DI water to make 1 L
total.

Caution! Do not mix BD Detergent Solution Concentrate
and bleach because they produce chlorine gas.

14. Repeat steps 2 through 11 with DI water.

15. Replace the sheath filter and refill the sheath container with
sheath fluid.
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Next step Test the waste management system battery as described in
Maintaining the waste management system (page 53).
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Maintaining the waste management system

Introduction This topic describes how to maintain the waste management
system. The waste management system has an alarm powered by a
9-volt battery that you must test and change regularly to ensure
continued operation.

When to perform  Test the battery every two weeks after you flush the system.
the battery test Change the battery as needed.

Testing the battery To test the battery and alarm:

and alarm 1. Locate the Battery Test switch on the waste container bracket.

. :‘ Battery test

BATTERY TEST

2. Toggle the switch.

If the battery and the alarm are working properly, you should
hear an alarm buzzing. If you do not hear any sound, change
the battery as described in the following section.

3. Release the switch.
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Changing the You need the following supplies to change the battery:
battery
e Small flat-head screwdriver

¢ A 9-volt battery
To change the battery:

1. Insert the tip of a flat-head screwdriver into the slot and gently
slide the battery drawer out.

2. Remove the drawer.
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3. Remove the battery from the drawer.

4. Place a new 9-volt battery into the drawer.

The markings in the battery drawer show the correct battery
orientation.

5. Slide the drawer into the bracket until you feel a click.

6. Test the new battery.
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Replacing the waste air filter

Introduction This topic describes how to replace the waste air filter. An air filter
is located on the cap assembly of the waste container.

Procedure

Caution: Biohazard! Treat a contaminated air filter as
biohazardous waste.

To replace the air filter:

1. Remove the air filter.

Hold the silicone tubing with one hand and pull off the filter
with the other hand.

2. Insert a new air filter into the silicone tubing.

3. Verify that the cap assembly on the container is tightened.
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Changing the sheath filter

Introduction This topic describes how to change the sheath filter. The sheath
filter is connected in-line with the sheath line. It filters the sheath
fluid as it comes from the sheath container.

When to change We recommend changing the sheath filter assembly every

the sheath filter six months. Increased debris appearing in an FSC vs SSC plot can
indicate that the sheath filter needs to be replaced. See Supplies and
consumables (page 175) for ordering information.

Sheath filter
components

Sheath line

Vent fitting

Quick-disconnect )
Vent line

Filter base
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Removing the old
filter

Attaching the new
filter

To remove the old filter:

1.
2.

Place the cytometer in standby mode.

Remove the sheath filter assembly by pressing the
quick-disconnect on both sides of the filter assembly.

Over a sink or beaker:

e Remove the vent line from the filter and set it aside.
e Remove the filter base and set it aside.

Discard the used filter assembly in an appropriate receptacle.

To attach the new filter:

1.

Connect the vent line to the new filter assembly.
Twist to attach.

Wrap Teflon® tape around the filter threads, then connect the
filter to the filter base.

Connect the sheath line to the filter assembly by squeezing the
quick-disconnect.

Attach the cytometer fluid line to the filter assembly via the
quick-disconnect.

Direct the vent line into a beaker and press the small button at
the end of the vent fitting against the side of the beaker until a
steady stream of fluid empties from the filter.

Tilt the filter and verify that no trapped air remains in the
filter.

Repeat steps 5 and 6 as necessary to remove all trapped air.




Chapter 4: Maintenance | 59

Changing the Bal seal

Introduction

When to change
the Bal seal

Procedure

This topic describes how to replace the Bal seal.

The sample injection tube Bal seal is a ring that forms a seal with
the sample tube and ensures proper tube pressurization.

Over time, the Bal seal becomes worn or cracked and requires
replacement. Replacement is necessary if a proper seal is not
formed when a sample tube is installed on the SIP. Indications that
a proper seal has not formed include:

e The tube will not stay on the SIP without the tube support
arm.

¢  When the tube is installed and RUN is pressed on the
cytometer, the RUN button is orange (not green).

To replace the Bal seal:

1. Remove the outer sleeve from the sample injection tube by
turning the retainer counter-clockwise. Slide the outer sleeve
down and off of the sample injection tube.

Bal seal

Retainer

Outer sleeve

Sample injection tube

Work carefully. The outer sleeve can fall off as you loosen the
retainer.
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2. Remove the Bal seal by gripping it between your thumb and
index finger and pulling down.

[

3. Install the new Bal seal spring-side up.

Ensure that the sample tube O-ring is still in place inside the
retainer.

4. Re-install the retainer and outer sleeve over the sample
injection tube. Push the outer sleeve all the way up into the
sample injection port and then screw the retainer into place
and tighten to finger tight. This will seat the Bal seal.

5. Install a sample tube on the SIP to ensure that the outer sleeve
has been properly installed.

If the sleeve hits the bottom of the tube, loosen the retainer
slightly and push the sleeve up as far as it will go. Tighten the
retainer.
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Changing the sample tube O-ring

Introduction

When to replace
the O-ring

Caution

Procedure

This topic describes how to replace the sample tube O-ring.

The sample tube O-ring, located within the retainer, forms a seal
that allows the droplet containment vacuum to function properly.

Replace the O-ring when droplets form at the end of the sample
injection tube while the vacuum is operating.

contaminated with biohazardous material. Wear suitable
protective clothing, eyewear, and gloves whenever
cleaning the cytometer or replacing parts.

f Caution: Biohazard! Cytometer hardware might be

To change the O-ring:

1. Remove the outer sleeve from the sample injection tube by
turning the retainer counter-clockwise.

2. Slide the outer sleeve from the retainer.

O-ring

Retainer




3. Invert the outer droplet sleeve and allow the O-ring to
fall onto the benchtop.

If the O-ring does not fall out initially, hold the O-ring
with your free hand and slide the outer sleeve to remove
the O-ring.

4. Place the new O-ring into the retainer. Make sure the
O-ring is seated properly in the bottom of the retainer.

5. Replace the outer sleeve in the retainer.
6. Re-install the retainer and the outer sleeve.

7. Install a sample tube on the SIP to ensure that the outer

This phyecihtehtiomadietbfobkiisk-

If the sleeve hits the bottom of the tube, loosen the
retainer slightly and push the sleeve up as far as it will
go. Tighten the retainer.
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Optimizing cytometer settings

This chapter covers the following topics:

e Cytometer settings workflow (page 64)

e Verifying the configuration and user preferences (page 66)
¢ Running a performance check (page 68)

e Setting up an experiment (page 72)

e Creating application settings (page 76)

® Recording compensation controls (page 79)

e (Calculating compensation (page 82)



64 | BD LSRFortessa X-20 Cell Analyzer User’s Guide

Cytometer settings workflow

Introduction

When to optimize
settings

Manual
compensation

First-time users

Before you begin

Workflow for
optimizing settings

This topic describes how to optimize cytometer settings. The
optimization is performed using the Cytometer Setup and
Tracking, Application Settings, and Compensation Setup features
of BD FACSDiva software.

Before you record data for a sample, optimize the cytometer
settings for the sample type and fluorochromes used.

Compensation setup automatically calculates compensation
settings. If you choose to perform compensation manually, not all
of the following instructions apply. For detailed instructions, see
the BD FACSDiva Software Reference Manual.

If you are performing the procedures in this workflow for the first
time, you should be familiar with BD FACSDiva software
concepts: workspace components, cytometer and acquisition
controls, and tools for data analysis.

For additional details, see the BD FACSDiva Software Reference
Manual.

Start the special order BD LSRFortessa X-20 cell analyzer and
perform the setup and QC procedures. See Cytometer setup
(page 29).

Cytometer optimization consists of the following steps.

Step | Description

1 Verifying the configuration and user preferences (page 66)

2 Running a performance check (page 68)

3 Setting up an experiment (page 72)
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Step | Description

4 Creating application settings (page 76)

S Recording compensation controls (page 79)
6 Calculating compensation (page 82)

Note: Application settings are optional and do not have to be
saved for the experiments. However, they are useful for optimizing
cytometer settings.

About the The examples in this chapter use a 4-color bead sample with the
examples following fluorochromes:

e FITC

e PE

e PerCP-Cy™S5.5

e APC

If you follow this workflow with a different bead sample (or
another sample type), your software views, data plots, and
statistics might differ from the example. Additionally, you might
need to modify some of the instructions in the procedure.

The information shown in italics is for example only. You can
substitute your own names for folders and experiments.
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Verifying the configuration and user preferences

Introduction This topic describes how to verify the cytometer configuration and
user preferences before you create an experiment.

cytometer configuration must reflect your

f Caution! To obtain accurate data results, the current
BD LSRFortessa X-20 cell analyzer optics.

Procedure To verify the configuration and preferences before you create an
experiment:

1. Select Cytometer > View Configurations and verify the current
configuration.

6-Blue 4-Red 5-Violet 2-NUV

6-Blue 4-Red 5-Violet 2-NUY.

6-Blue 4-Red 6-Violet 2-NUV
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Window Extenson (5):  10.00 Conments:

Your cytometer might include only the base configuration
when your cytometer is installed. You can create additional
configurations later as needed.

In this example, the cytometer configuration must include the
following parameters: FITC, PE, PerCP-Cy5.5, and APC.
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2. If you need to select a configuration other than the current
configuration:

a. In the Configurations tab, select a configuration.
b. Click Set Configuration.
c. Click OK.

d. Verify that the configuration you just set matches your
BD LSRFortessa X-20 cell analyzer optics.

Click OK to close the Cytometer Configuration window.
Select File > Exit to close CS&T.

Select Edit > User Preferences.

A T

Click the General tab and select the Load data after recording
checkbox.

See the BD FACSDiva Software Reference Manual for more
information about cytometer configurations and user preferences.

Next step Running a performance check (page 68)

More information e  Setting up an experiment (page 72)
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Running a performance check

Introduction

Overview

Considerations

Before you begin

This topic describes how to run a performance check as part of
quality control.

The CS&T application is designed to monitor performance on a
daily basis and to optimize laser delay.

Running a performance check on a regular basis provides a
standard for monitoring changes in performance due to
degradation of laser power, aging of PMTs, and other potential
cytometer service issues. Performance results are also affected by
fluidics performance. We strongly recommend following the
fluidics maintenance procedures as described in Cleaning the
fluidics (page 47).

Some BP filters might not be normalized to CS&T settings. In this
case, CS&T will generate Qr and Br numbers that are not
comparable from instrument to instrument. They are however, still
trackable on one cytometer. Part of the process for optimizing
cytometer settings includes verifying PMT voltages set by CS&T
for all parameters. Carefully examine any channel with a non-
CS&T normalized filter.

Define the performance baseline for any configuration before
running a performance check. See Custom configurations and
baselines (page 43).
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Procedure To run a performance check:

1. Select Cytometer > CST.

2. Verify that the bead lot information under Setup Beads
matches the Cytometer Setup and Tracking bead lot.

Setup Beads

Lok ID: 54102 W
Product; Z5T Setup Beads

Fart #: Q10723

Ewpiration Date:  09-30-2011

3. Verify that the cytometer configuration is correct for your
experiment.

System Summary: 0K

{ Cytometer Configuration: Custem 6-Blue 4-Red &-Vilek 2-UV )
Lot ID; 54102

If the cytometer is not set to the correct configuration:

a. Click Select Configuration in the Setup Control window.
b. Select the correct configuration from the list.
c. Click Set Configuration and then click OK.

4. Verify that the current configuration has a valid baseline

defined.

If not, see the BD Cytometer Setup and Tracking Application
Guide for more information on defining a baseline.

5. Prepare the CS&T beads according to the technical data sheet
provided with the beads or available on the BD Biosciences
website (bdbiosciences.com).


http://www.bdbiosciences.com
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6.
7.

10.
11.

Install the bead tube onto the SIP.

In the Setup Control window, select Check Performance from
the Characterize menu.

Charackerize: lChEtk Perfarmance 1]

Click Run.

Ensure that the SAMPLE FINE AD]J knob is set to the
midpoint and press RUN and LOW.

Plots appear under the Setup tab and the performance check is
run. The performance check takes approximately 5 minutes to
complete.

Once the performance check is complete, click View Report.
Verify that the cytometer performance passed.

In the Setup tab, the cytometer performance results should
have a green checkbox displayed and the word Passed next to
it.

@ Cutoeresles Bagelns: January 18, 2010 1026 &M

E2] Cyloensled Peiloimancs: Jeousary 20, 2010 03:03 P
@] Cyloenaled Petlcemancs Resdls: Pas-:-ed)

If any parameters did not pass, see the BD Cytometer Setup
and Tracking Application Guide for troubleshooting
information.
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12. Select File > Exit to close the CS&T window and return to the
BD FACSDiva interface.

The CST Mismatch dialog opens.

i CST Mismateh

The settings from CST are different from those on the cybometer.
3
.

Do you weant bo uss the CST values?
] Dran't show thiz message again for current login session.
| Detais>> || usecsTsettings | [ Keep Current Settings |

Remember my decision.

Click the Details button to verify which cytometer settings will
be updated.

13. Click Use CST Settings.

By selecting Use CST Settings, the laser delay, area scaling, and
other cytometer settings will be updated to the latest settings
from the performance check.

Next step Continue the optimization of your cytometer for an experiment or
sample type as described in Setting up an experiment (page 72).
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Setting up an experiment

Introduction

Creating an
experiment

This topic describes how to create an experiment in a new folder,
specify the parameters of the experiment, and add compensation
tubes.

To create an experiment:

1.

Click the buttons on the Workspace toolbar to display the
following windows as needed:

* Browser

¢ Cytometer

¢ Inspector

e Worksheet

¢ Acquisition Dashboard

When you add elements or make selections in the Browser, the
Inspector displays details, properties, and options that
correspond to your selection.

Click the New Folder button on the Browser toolbar to add a
new folder.

Click the folder and rename it MyFolder.

Click MyFolder, then click the New Experiment button on the
Browser toolbar.

[’¥ Browser - MyExperiment
GECrCE @
\_i Mew Experiment | |

I'] Mame
=3 Administrator
] r'-'1':.-'F|:|I|:|er'

a. Click the new experiment in the Browser and rename it
MyExperiment.
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5. Select MyExperiment in the Browser.

The Inspector displays details for the experiment.

To specify the parameters for the new experiment:

1. Select Cytometer Settings for the experiment in the Browser.

=-[k] MyEzxperiment 1/4/07 8:54:15..,
52 Cytometer Settings h

@ Global Worksheets

Cytometer settings appear in the Inspector.

F& Inzpector - Cytometer Settings

Cytometer Settings |

Peramaters | Theshold | Ratin | Compensation |
Veltage
kol
266

FLTC

FE

FE-Texas Red
FE-CyS
ParCP-Cy5.5
PE-Cy7?

HEEEEEE|
O0OoooOooOoo =

Dooooooooo =

IEEREEEEREOO :

IS
10

2. Make sure the parameters you need appear on the Parameters
tab in the Inspector.

If more than one parameter is available for a particular PMT,
you might have to select the one you need from a menu. For
example, you can set Detector F for the blue laser as FITC or
Alexa Fluor™ 488.
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a. Click the Parameter name to display the available
fluorochromes in the Parameters list.

Inspector - Cytometer Settings

Cykometer Setkings |
Parameters | Threshold | Ratio | Compensatic
Pararneker Wi
e F5C 250
e S5 300
N
* PE 00

b. Select the specific parameter from the menu. Your selection
appears as the selected parameter.

Inspector - Cytometer Settingg

Cytometer Settings

Farameters | Threshald || Ratio || o

Parameter
e FSC
F 55C
r |FITiC W
e |Alexa Fluor 453

. E—

c. For this example, select FITC from the menu.

3. Delete any unnecessary parameters.
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a. Click the selection button (to the left of the parameter
name) to select the parameter.

Inspector - Cytometer Settings

Cytometer Settings |
Parameters | Threshold || Ratio || Compensati0n|
Parameter Voltage Log A H W

- FSC 250 [ | O
e S5C 300 O O O
¢ FITC =00 O O
- FE 500 o | 0d
PerCP-CyS-5 ] [
( 00 H H
Pacific Elue S00 O O
¢ AmCyan 500 O O
¢ Indo-1 (Vilet) 500 O O
* Indo-1 (Blue) 500 O O

Add [ Delete I

| Sl

b. Click Delete.

The parameter is deleted.
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Creating application settings

Introduction

About application
settings

Before you begin

Procedure

This topic describes how to create application settings.

Application settings are associated with a cytometer configuration
and include the parameters for the application, area scaling values,
PMT voltages, and threshold values, but not compensation. Each
time a performance check is run for a configuration, the
application settings associated with that configuration are updated
to the latest run.

Using application settings provides a consistent and reproducible
way to reuse cytometer settings for commonly used applications.

You can include area scaling adjustment in your application
settings. See Adjusting area scaling (page 169) for more
information.

Perform the cytometer setup procedure and run a performance
check for the configuration that will be used for the application.

To create application settings:
1. In the open experiment, right-click Cytometer Settings in the
Browser, then select Application Settings > Create Worksheet.

A second global worksheet is added with the plots created
according to the selections in the Parameters tab.
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Use the gray boxes and crosshairs to guide your optimization.
Load the unstained control tube onto the cytometer.

In the Cytometer window, optimize the PMT voltages for the
application.

¢ Optimize the FSC and SSC voltages to place the population
of interest on scale.

e Optimize the FSC threshold value to eliminate debris
without interfering with the population of interest.

e If needed, increase the fluorescence PMT voltages to place
the negative population within the gray boxes. Align the
center of the negative population with the crosshair visible
in the gray box.

Note: Do not decrease the fluorescence PMT voltages. Doing
so can make it difficult to resolve dim populations from the
negative population.

Unload the unstained control tube from the cytometer.

Load the multicolor sample onto the cytometer or load single-
color control tubes and verify each fluorochrome signal
separately.
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6.

Verify that the positive populations are on scale.

If a positive population is off scale, lower the PMT voltage for
that parameter until the positive population can be seen
entirely on scale.

7. Unload the multicolor sample.

8.

9.

Place a tube containing DI water on the SIP and put the
cytometer on standby.

(Optional) Save the application settings by right-clicking
Cytometer settings in the Browser, then selecting Application
Settings > Save.

10. In the Save Application Settings dialog, enter a descriptive

name for the application settings.

Save Application Settings

Enter a name for the Application Settings

| LSRFortessa 4 Color Application Settings |

[ Ok ] [ Cancel ]

11. Click OK.

The application settings are saved to the catalog.

Next step Recording compensation controls (page 79)
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Recording compensation controls

Introduction This topic describes how to create and record compensation
controls using the Compensation Setup feature of BD FACSDiva
software and an experiment with optimized settings.

Creating To create compensation control tubes:
compensation 1

tub Select Experiment > Compensation Setup >
ubes

Create Compensation Controls.
The Create Compensation Controls dialog opens.

For this bead example, you do not need to provide non-generic
tube labels.

¥ Modify Compensation Controls

include separate unstained control bube fwelt
Fluorophore Label
* FITC (Generic
* PE (Generic
# PerCP-Cy5-5 GEneric
* APC (Generic

2. Click OK.
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Recording
compensation
settings

Compensation control tubes are added to the experiment.
Worksheets containing appropriate plots and gates are added
for each compensation tube.

W Unstained Cont
-~ W FITC Stained Co
[ PE Stained Canl
- |J PerCP-Cy5-5 5t
W APC Stained Co

To record compensation settings:

1.
2.

Press RUN and HIGH on the cytometer fluid control panel.
Install the unstained control tube onto the SIP.
Expand the Compensation Controls specimen in the Browser.

Set the current tube pointer to the unstained control tube (it

becomes green), then click Acquire Data in the Acquisition
Dashboard.

Verify that the population of interest is displayed appropriately
on the FSC vs SSC plot and adjust voltages if necessary.

0
1

nstained Control

i

1

SS5C-A (x 10007
0

hi

ey

||||||.||.|||i|.|-||||"||||||||
a0 100 150 00 450
For-m iz 1,0007%
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10.

11.

12.
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Since the application settings have been optimized for your
sample, the cytometer settings should not require adjustment
other than the changing of FSC and SSC voltages to place the
beads on scale.

Adjust the P1 gate to surround only the singlets.

Right-click the P1 gate and select Apply to All Compensation
Controls.

The P1 gate on each stained control worksheet is updated with
your changes.

Click Record Data.

When recording is finished, remove the unstained control tube
from the cytometer.

Click Next Tube.

Caution! Do not change the PMT voltages after the

A first compensation control has been recorded. In
order to calculate compensation, all controls must
be recorded with the same PMT voltage settings. If
you need to adjust the PMT voltage for a
subsequent compensation control, you must record
all compensation controls again.

Install the next tube onto the cytometer and repeat steps 8
through 10 until data for all stained control tubes has been
recorded.

Double-click the first stained control tube to display the
corresponding worksheet.
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Next step

13. Verify that the snap-to interval gate encompasses the positive

population.

FITC-Stained Control

FITC Stained Control

@

S8C-A (x1,000)
ﬁlﬂ 1?0 1?0 QIFL'I 2?0

Count
10 200 390 40 s

50 100 1450
FSC-A

00 260
(x 1,000)

|||I|||| T ||l||||| T |l|||||| T ||||||1 T
10 10% 10¢ 104

FITC

14. Repeat steps 12 and 13 for the remaining compensation tubes.

After you have recorded data for each single-stained control,
calculate compensation as described in Calculating compensation

(page 82).

Calculating compensation

Introduction

Before you begin

Procedure

This topic describes how to calculate compensation.

Before you can calculate compensation, you need to record the

data for each single-stained control.

To calculate compensation:

1. Select Experiment > Compensation Setup > Calculate

Compensation.

Note: If the calculation is successful, a dialog prompts you to
enter a name for the compensation setup. The default name is

year/month/day/time.




More information
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2. Enter a setup name and click Link & Save.

The compensation is linked to the cytometer settings and saved
to the catalog.

To help track compensation setups, include the experiment
name, date, or both in the setup name.

The compensation setup is linked to the MyExperiment
cytometer settings, and subsequent acquisitions in
MyExperiment are performed with the new compensation
settings.

We recommend that you always visually and statistically inspect
automatically calculated spectral overlap values. The means of the
positive controls should be aligned with the means of the negative
controls.

® Recording compensation controls (page 79)
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Recording and analyzing data

This chapter covers the following topics:

® Data recording and analysis workflow (page 86)
e Preparing the workspace (page 87)

e Recording data (page 88)

* Analyzing data (page 91)

e Reusing an analysis (page 97)
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Data recording and analysis workflow

Introduction

About the
examples

Workflow for
recording and
analyzing data

This topic outlines the basic acquisition and analysis tasks using
BD FACSDiva software.

The examples in this chapter are from two 4-color bead samples
with the following fluorochromes:

e FITC

e PE

e PerCP-CyS.5
e APC

If you use a different sample type or if you have skipped the
optimization steps in Optimizing cytometer settings (page 63),
your software window content, names of folders and experiments,
and your data plots and statistics might differ from those shown
here. You might also need to modify some of the instructions in the
procedure.

For additional details on completing some of the following steps,
see the BD FACSDiva Software Reference Manual.

This procedure builds on the results obtained in Optimizing
cytometer settings (page 63).

Recording and analyzing data consists of the following steps.

Step Description

1 Preparing the workspace (page 87)
2 Recording data (page 88)
3 Analyzing data (page 91)

4 Reusing an analysis (page 97)
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Preparing the workspace

Introduction

Procedure

Applying saved
application settings
to a new
experiment

This topic describes how to prepare the workspace and apply
application settings to your experiment before recording data.

To prepare the workspace:

1. Using the Browser toolbar, create a new specimen in
MyExperiment and rename it FourColorBeads.

2. Create two tubes for the FourColorBeads specimen. Rename
the tubes Beads_001 and Beads_002.

3. Expand the Global Worksheets folder in MyExperiment to
access the default global worksheet, and rename the worksheet
MyData.

4. On the MyData worksheet, create the following plots for
previewing the data:

FSC vs SSC

FITC vs PE

FITC vs PerCP-CyS$.5
FITC vs APC

When applications settings are applied to an experiment, the
cytometer settings are updated with the parameters included in the
application settings, optimized PMT voltages, threshold settings,
area scaling factors, and window extension values.

To apply saved application settings to your experiment:

1. Right-click the experiment-level Cytometer Settings and select
Application Settings > Apply.
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2. In the Application Settings catalog, select the application
settings file you saved previously and click Apply.

If the parameters are not the same, a mismatch dialog opens.

¢ Click Overwrite to update all settings.

* Click Apply to change only the common parameters.
For more information, see the BD FACSDiva Software
Reference Manual.

The cytometer settings are renamed application settings and the
cytometer settings icon in the Browser changes.

More information e  Creating application settings (page 76)

e Recording data (page 88)

Recording data

Introduction This topic provides an example of how to preview and record data
for multiple samples.

Before you begin  Prepare the sample tubes.

Recording data To record data:
1. Press RUN and HIGH on the cytometer fluid control panel.

2. [Install the first sample tube onto the SIP.
3. Set the current tube pointer to Beads_001.

4. Click Acquire Data in the Acquisition Dashboard to begin
acquisition.
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While data is being acquired:

a. Draw a gate around the singlets on the FSC vs SSC plot.
b. Rename the P1 gate to Singlets.

c. Use the Inspector to set the other plots to show only the
singlet population by selecting the Singlets checkbox.

Population

B &l Everts
~ [l singlets
Click Record Data.

When event recording has completed, remove the first tube
from the cytometer.

The MyData worksheet plots should look like the following.

FourColorBeads-Beads_001 FourColotBeads-Beads_001
aF .
s 2 <
g g,
L TTTT | TTTT | TTTT | TTTT | TTTT | T
50 00 A0 w0 350
(259260, 185046) FSC-A G 1.000) FITC-A
FourCaolorBeads-Beads_001 FourCaolorBeads-Beads_001

108

PercP-cys.5
1n*

10?
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More information

10.
11.

12.

13.

14.

15.

16.
17.

Install the second sample tube onto the SIP.
Set the current tube pointer to Beads_002.
Click Acquire Data to begin acquisition.

Before recording, preview the data on the MyData worksheet
to verify that all expected populations are visible and the data
is similar to the previous sample.

Click Record Data.

When event recording has completed, remove the second tube
from the cytometer.

If you are recording more than two tubes, repeat steps 8
through 13 for the remaining tubes.

Print the experiment-level cytometer settings by right-clicking
the Cytometer Settings icon in the Browser and selecting Print.

Install a tube of DI water onto the SIP.

Place the cytometer in standby mode.

Analyzing data (page 91)
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Analyzing data

Introduction

Analyzing data

This topic describes how to analyze recorded tubes by creating
plots, gates, a population hierarchy, and statistics views on a new
global worksheet.

To analyze data:

1. Use the Browser toolbar to create a new global worksheet.
Rename it MyDataAnalysis.

2. Create the following plots on the MyDataAnalysis worksheet:

e FSCvs SSC
e FITCvs PE
e FITC vs PerCP-CyS5.5
e FITC vs APC
3. Create a population hierarchy and a statistics view, and set
them below the plots on the worksheet.
e Right-click any plot and select Show Population Hierarchy.
e Right-click any plot and select Create Statistics View.
4. Set the current tube pointer to Beads_001.

5. Draw a gate around the singlets on the FSC vs SSC plot.

6. Use the population hierarchy to rename the population
Singlets.
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7. Select all plots except the FSC vs SSC plot, and use the Plot tab
in the Inspector to specify to show only the singlet population.

Inspector - Dot Plot

Tube:
# Parameter: FaiC-A W
Y Parameter: S5C-A W

Biexponential Display
[] % fxis
[ Axis

Flat Elements

[]arid Plot Cutline Tick Labels
Backaround Calar: [+] Grid Outline Tick Marks

[] @ Ful O Half

Population Diraw
[ 11l &l Everts
C[+| I Singlets 1 ™

8. Select all plots, and click the Title tab in the Inspector.
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9. Select the Tube and Populations checkboxes to display their
names in plot titles.

Inspector - Dot Plot

|_F'E| Title | Labels | Acquisition | Dat F'I-n:Ei

Title Content

[] Custam Title:] -

Title Faonk

Face: |5ansSeriF v| Size: | 1z | Colar: .

[ ]Italc [ ]EBold

10. On all fluorescence plots:

e Make all plots biexponential. Select all fluorescence plots
and select the X Axis and Y Axis checkboxes in the Plot tab
of the Inspector.

Inspector - Dot Plot

Plot | Title | Labels | Acquisition | Dot Plat |

Tube: eads, Specimen_001.Beads_001
# Parameter: FSC-8 b
Y Parameter: S5C-4 b
Cyhometer Setup
Show target values of Dim beads

Bigxponential Display
% Biis
¥ Axis
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In the FITC vs PE plot, draw a gate around the
FITC-positive population. Name the population FITC
positive in the population hierarchy.

In the FITC vs PE plot, draw a gate around the PE-positive
population. Name the population PE positive in the
population hierarchy.

In the FITC vs PerCP-CyS5.5 plot, draw a gate around the
PerCP-CyS5.5-positive population. Name the population
PerCP-CyS5.5 positive in the population hierarchy.

In the FITC vs APC plot, draw a gate around the APC-
positive population. Name the population APC positive in
the population hierarchy.

11. Format the statistics view.

a. Right-click the statistics view and select Edit Statistics

View.

Click the Header tab and select the Specimen Name and
Tube Name checkboxes.

Click the Populations tab and select all populations except
All Events. Clear the %Parent, %Total, and #Events
checkboxes.

Click the Statistics tab and select the mean for each of the
fluorescence parameters.
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¥ Edit Statistics Yiew

Header ii_PopuIat_iR Statistics |

e @ ) [P s Fan an ey o R ) [
All Ilin Max |GeoM...| Mean | Median D 5D alZ e Mode
FaC-A B A El il il Ll El il il [ i
S5C-A F M L] Ll O O L] Ll L] O |
FITC-A B ® El il Ll El il il [ i
PE-A L O O O O O O O [
PerCP-CyS .5 B B F O O F O il O il
APC-A E M L] Ll O L] Ll O O i
Time B ® El il il Ll El il il [l i
Decimal Places a ] a a a ] a it 1 a
(%) Sort by Parameter () Sart by Formula
[] Display F.angs |!_ inear Scale (0-10,000)

e. Click OK.

12. Print the analysis.
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Your global worksheet analysis objects should look like the

following.
_ Beads _001-All Events Eeads_001-Singlets
.:.E |- PE positive
557 i '
2.7 £,
BE o] FITC post
_IIII|I..II..I|I.I.II|.IIII|IIII|I TTTITm IIIIIIII| IIIIIIII| T
S0 100 180 00 250 w? 10? 1t 10
FSC-4 0 1,000 FITC-4
Beads_001-Singlets Beads_001-Singlets
g‘r PerCP-Cy 5.5 positive o ARC positive
i <
< &1
&7 Ty
_I il‘lllll T IIIIII| L IIIIII| L IIIIII| T L IIIIII| TT IIIIII| T
w? 10? 1t 10d 1t 10d
FITC-A FITC-A
Tube: Beads_001
Fopulation #Events %Parent %Total
W 4l Events 10,000 1000
Ll singlets 9,675 968 0GB
FITC positive 4,774 493 477
FE positive 1,499 1548 150
FPerCP-Cy5.5 positive 1,529 15.8 158.3
AP positive 1,829 1849 183
Specimen Mame: FourColorBeads
Tube Mame: Beads_001
FITC-A FPE-A FPerCP-Cy5.5-A  APC-A
Fopulation Mean Mean Mean Mean
M singlets 1,969 1,727 1,287 3,956
E FITC positive 3,880 40 43 k]
B FE positive 95 10,858 T 16
W FercP-Cys.5 positive 106 GE 7639 380
O aPc positive 91 a9 a4 20,482
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More information e Reusing an analysis (page 97)

Reusing an analysis

Introduction This topic describes how to use a global worksheets to apply the
same analysis to a series of recorded tubes. Once you define an
analysis for a tube, you can use it to analyze the remaining tubes in
the experiment. After viewing the data, print the analysis or save it
to a normal worksheet.

Reusing an analysis To reuse the analysis:
1. Set the current tube pointer to the Beads_002 tube.

2. View the Beads_002 data on your analysis worksheet. Adjust
the gates as needed.

Adjustments apply to subsequent tubes viewed on the
worksheet. To avoid altering a global worksheet, save an
analysis to a normal worksheet, then make adjustments on the
normal worksheet.

3. Print the analysis.

Saving the analysis When you perform analysis with a global worksheet, the analysis
does not save with the tube.

If you define your analysis on a global worksheet before recording
data, you can specify to automatically save the analysis after
recording data. You set this option in User Preferences.

To save a copy of the analysis with a tube:

1. Expand the MyDataAnalysis global worksheet icon in the
Browser.
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Applying an
analysis to normal
worksheets

More information

2. Right-click its analysis and select Copy.

=[] FourColorBaads
----- E% Cybomeker Settings
EI@ Global Worksheets
: EI My Daka Analysis

™ analysis

3. Click the Worksheets View button on the Worksheet toolbar to
switch to the normal worksheet view.

4. Select Worksheet > New Worksheet to create a new normal
worksheet.

5. Right-click the Beads_001 tube icon in the Browser, and select
Paste.

M FourColorBeads |

M ocut Chrk+¥
% Copy Zhrl+C

G-

| Beads_no2
= Shared View

Delete Delete

The analysis objects from the MyDataAnalysis global
worksheet are copied to the Beads_001_Analysis normal
worksheet. Double-click the Beads_001 tube in the Browser to
view the analysis.

You can apply the global worksheet analysis to multiple tubes (on
a single normal worksheet) by selecting multiple tubes before
pasting the analysis. Ensure that you collapse all tube elements in
the Browser before you paste them to multiple tubes.

® Analyzing data (page 91)




7

Technical overview

This chapter provides a technical overview of the following topics:

e About fluidics (page 100)
* About optics (page 101)
e About electronics (page 112)
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About fluidics

Introduction

Pressure-driven
fluidics system

Hydrodynamic
focusing

Low sample
pressure
(12 yl/min)

|

Sample

This topic describes the fluidics system in the special order
BD LSRFortessa X-20 cell analyzer.

The fluidics system in the BD LSRFortessa X-20 cell analyzer is
pressure-driven. A built-in air pump provides a sheath pressure of
5.5 psi. After passing through the sheath filter, sheath fluid is
introduced into the lower chamber of the quartz flow cell.

The sample to be analyzed arrives in a separate pressurized stream.
When a sample tube is placed on the SIP, the sample is forced up
and injected into the lower chamber of the flow cell by a slight
overpressure relative to the sheath fluid. The conical shape of the
lower chamber creates a laminar sheath flow that carries the
sample core upward through the center of the flow cell, where the
particles to be measured are intercepted by the laser beam. This
process is known as hydrodynamic focusing.

High sample
pressure
(60 pl/min)

Laser beam Laser beam

Sheath Y

fluid

Sheath
fluid

Sheath
fluid

Sample
The objective in flow cytometric analysis is to have at most one cell
or particle moving through a laser beam at a given time. The
difference in pressure between the sample stream and sheath fluid
stream can be used to vary the diameter of the sample core.
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Increasing the sample pressure increases the sample flow rate
thereby increasing the core diameter. The flow rate should be set
according to the type of application you are running.

* A higher flow rate is generally used for qualitative
measurements such as immunophenotyping. The data is less
resolved, but is acquired more quickly.

e A lower flow rate is generally used in applications where
greater resolution and quantitative measurements are critical,
such as DNA analysis.

Proper operation of fluidic components is critical for particles to
intercept the laser beam properly. Always ensure that the fluidics
system is free of air bubbles and debris, and is properly
pressurized.

About optics

Introduction This topic describes the optics system and provides information
about:

e Light scatter (page 102)
®  Fluorescence (page 102)

e Optical filter theory (page 104)
e Compensation theory (page 109)

Optics system The optics system consists of lasers, optical filters, and detectors.
Lasers illuminate the cells or particles in the sample and optical
filters direct the resulting light scatter and fluorescence signals to
the appropriate detectors.
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Light scatter

Fluorescence

When a cell or particle passes through a focused laser beam, laser
light is scattered in all directions. Light that scatters axial to the
laser beam is called forward scatter (FSC) and light that scatters
perpendicular to the laser beam is called side scatter (SSC).

Side scatter (SSC)

Light source Forward scatter (FSC)

FSC and SSC are related to certain physical properties of cells.

¢ FSC. Indicates relative differences in the size of the cells or
particles. Larger cells scatter more light and therefore they are
higher in FSC.

e SSC. Indicates relative differences in the internal complexity or
granularity of the cells or particles. More granular cells deflect
more light than less granular cells, and therefore are higher in
SSC.

When cells or particles stained with fluorochrome-conjugated
antibodies or other dyes pass through a laser beam, the dyes can
absorb photons (energy) and be promoted to an excited electronic
state. In returning to their ground state, the dyes release energy,
most of which is emitted as light. This light emission is known as
fluorescence.

Fluorescence is always a longer wavelength (lower-energy photon)
than the excitation wavelength. The difference between the
excitation wavelength and the emission wavelength is known as
the Stokes shift. Some fluorescent compounds such as PerCP
exhibit a large Stokes shift, absorbing blue light (488 nm) and
emitting red light (675 nm), while other fluorochromes such as
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FITC have a smaller Stokes shift, absorbing blue light (488 nm)
and emitting green light (530 nm).

The following figure shows the emission spectra of some
commonly used fluorochromes.

a0

FerCP

a L
AmCyan FE = b
Alezea TOO

FITC

APC-HT

FerCP Cy-5.5

500 600 700 800
Wavelength (nm)

Actual emission intensity will depend on excitation wavelength.
See Fluorescence spectra (page 130) for more information on
excitation and emission of fluorochromes. An interactive spectral
viewer is also available at bdbiosciences.com.


http://www.bdbiosciences.com 
http:www/bdbiosciences.com 
http://www.bdbiosciences.com
http://www.bdbiosciences.com
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Optical filter theory Optical filters modify the spectral distribution of light scatter and

Types of optical
filters

fluorescence directed to the detectors. When photons encounter an
optical filter, they are either transmitted, absorbed, or reflected.

Photons
Photons absorbed Photons
transmitted reflected
\

Even though an optical filter is rated at its 50% transmission point,
the filter passes (lets through) a minimal amount of light outside of
this indicated rating.

The slope of an optical filter transmission curve indicates filter
performance. A relatively steep slope indicates a high-performance,
high-quality optical filter that provides deep attenuation of out-of-
band wavelengths. A less steep slope indicates that more light
outside the rated bandwidth is being transmitted.

There are four types of filters.

e Longpass (LP) filters. Transmit wavelengths that are longer
than the specified value.

e Shortpass (SP) filters. Transmit wavelengths that are shorter
than the specified value. This type of filter is not
recommended, but can be used in some custom configurations.
See Shortpass (SP) filters (page 106).

¢ Bandpass (BP) filters. Pass a narrow spectral band of light by
combining the characteristics of shortpass filters, longpass
filters, and absorbing layers.



Longpass (LP)
filters
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¢ Notch filters. Pass all frequencies except those in a stop band
centered on a center frequency. They are the opposite of
bandpass filters.

The BD LSRFortessa X-20 uses LP filters and BP filters. Notch
filters are sometimes used in special order BD LSRFortessa X-20
instruments.

LP filters pass wavelengths longer than the filter rating. For
example, a 500-LP filter permits wavelengths 500 nm or longer to
pass through it and either absorbs or reflects wavelengths shorter
than 500 nm.

Longpass
480 520
100 460 500 540
c
Re]
(%]
E 50 4— — — — — _
g ), - ~
o
= I
°\° LP 500
Y T ! T 1
450 500 550
Wavelength (nm)
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Shortpass (SP)
filters

An SP filter has the opposite properties of an LP filter. An SP filter
passes light with a shorter wavelength than the filter rating. For
example, a 500-SP filter passes wavelengths of 500 nm or shorter,
and reflects or absorbs wavelengths longer than 500 nm.

Shortpass
100 — 480 520
460 500 540
c
o
8 04— — — — — —
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Bandpass (BP) A BP filter transmits a relatively narrow range or band of light. BP

filters filters are typically designated by two numbers. The first number
indicates the center wavelength and the second refers to the width
of the band of light that is passed. For example, a 500/50-BP filter
transmits light that is centered at 500 nm and has a total
bandwidth of 50 nm. Therefore, this filter transmits light between
475 and 525 nm.

Bandpass
100 460 500 540
480 520
c
g
a
‘€ 50 o
g L1 ]
@ | [
= | I
2
I I
0 T T 1 T |
450 500 550

Wavelength (nm) "V

The performance of an optical BP filter depends on the optical
transmission. Sample transmission curves are shown in the
following figure. A filter with a narrower (steeper) transmission
curve generally yields higher performance. The transmission
specifications depend on the construction of the filter.

Higher performance filters generally have multiple layers of optical
coatings and unique manufacturing processes. For more
demanding multicolor applications, higher performance filters are
available through the special order research program. Contact
your local BD Biosciences sales representative for details.
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Dichroic mirrors

100

50

% Transmission

450 500 550
Wavelength (nm)

Dichroic filters that are used to direct different color light signals
to different detectors are called dichroic mirrors.

Although some of the properties of LP and SP filters are similar to
dichroic mirrors (for example, allowing a specific wavelength
range to pass), filters and mirrors cannot be used interchangeably,
especially if used as dichroic mirrors. A dichroic mirror must have
a surface coating that reflects certain wavelengths, but many LP or
SP filters are absorbance filters that do not have any specific
reflective characteristics. Also, optical filters and dichroic mirrors
are rated at a specific angle of incidence. When used in front of the
fluorescence detectors, they are perpendicular to the incident light,
and when used as a dichroic mirror, they are placed at an angle
relative to the light source. Their optical properties are therefore
designed for that angle of incidence.
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Compensation Fluorochromes emit light over a range of wavelengths. Optical

theory filters are used to limit the range of frequencies measured by a
given detector. However, when two or more fluorochromes are
used, the overlap in wavelength ranges often makes it impossible
for optical filters to isolate light from a given fluorochrome. As a
result, light emitted from one fluorochrome appears in a detector
intended for another. This is referred to as spillover. Spillover can
be corrected mathematically by using a method called
compensation.

In the following example, FITC emission appears primarily in the
FITC detector, but some of its fluorescence spills over into the PE
detector. The spillover must be corrected or compensated for.
Alternatively, the spillover can be minimized by discrete excitation
of fluorochromes. In the following example, excitation with a 561-
nm laser (special order) will help minimize spillover.

FITC PE
BP53030 BP575/26

Normalized intensity

T T 1
500 nm 550 nm 600 nm 650 nm 700 nm
Wavelength (nm)

This spillover can be seen in a dot plot of FITC vs PE. The FITC
spillover in the PE detector must be corrected as demonstrated in
the two figures that follow.
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FITC-positive
population

PE

Unstained
particles

FITC

Using the Compensation tab of the Cytometer window in

BD FACSDiva software, you can adjust the PE-%FITC spectral
overlap value. Compensation is optimal when the positive and
negative FITC populations have the same means in the PE
parameter statistics.

The following image shows the FITC spillover optimally
compensated out of the PE parameter.

FE-A
FITC-positive Faopulation Mean
PE . [ Unlabeled 20
population -
Unstained B FITC positive v
particles — ]

BN e e Matching means

FITC

Once fluorescence compensation has been set for any sample, the
compensation setting remains valid for a subsequent dim or bright
sample (provided the signal is not saturated), because
compensation subtracts a percentage of the fluorescence intensity.
The following figure illustrates this principle. Although the signals
differ in intensity, the percentage of the FITC spillover into the PE
detector remains constant.



Normalized intensity

FITC
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About electronics

Introduction

Pulse

This topic describes the electronics in the special order
BD LSRFortessa X-20 cell analyzer.

As cells or other particles pass through a focused laser beam, they
scatter the laser light and can emit fluorescence. Because the laser
beam is focused on a small spot and particles move rapidly through
the flow cell, the scatter or fluorescence emission signal has a very
brief duration—only a few microseconds. This brief flash of light is
converted into an electrical signal by the detectors. The electrical
signal is called a pulse. The following figures illustrate the anatomy
of a pulse.

1. A pulse begins when a particle enters the laser beam. At this
point, both the beam intensity and signal intensity are low.

B

/
Signal intensity

Time

2. The pulse reaches a maximum intensity or height when the
particle reaches the middle of the beam, where the beam and
signal intensity are the brightest. The peak intensity, or height
of the pulse, is measured at this point.

C
Signal intensity

Time
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3. As the particle leaves the beam, the pulse trails off below the

threshold.
2
L) 2
[}
e
=
C
o
wn
Time
Pulse The pulse processors measure pulses by three characteristics:
measurements height, area, and width.
Pulse Height
4]
o
8
9 Baseline
Threshold 1 HI 1 Z
0 volts e P
1 1 1 1
P -
1 : ! Window Gate ! -
ExWindnw Extension j«—, — ExWindnw Extension

Window Gate + Full Window Extension

e Height. The maximum digitized intensity measured for the
pulse.

®  Area. The integration of all the digitized samples over time,
where time is the window gate plus 1/2 the window extension
added before the initial threshold, plus the other half of the
window extension value added after the pulse drops below the
threshold. The window gate extends until the pulse is 75% of
the initial threshold.

e Width. Calculates: -A2_ 4 64000
Height
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Digital electronics

Threshold

BD LSRFortessa X-20 electronics digitize the signal intensity
produced by a detector. The digitized data is stored in memory and
further processed by the electronics to calculate:

e Dulse height, area, and width
¢ Compensation
e Parameter ratios

These results are transferred to your workstation computer for
further processing by BD FACSDiva software. For more
information about digital theory, see Digital Theory in the

BD FACSDiva Software Reference Manual.

The threshold is the level at which the system starts to measure
signal pulses. A threshold is defined for a specific detector signal.
The system continuously samples the digitized signal data and
calculates pulse area, height, and width for all channels based on
the time interval during which the threshold is exceeded.

Thresholds can also be set for more than one parameter, and pulse
measures are based on either of the following:

¢ Intervals during which ALL signals exceed their threshold
value (AND threshold in the software)

e Intervals during which ANY signal exceeds its threshold value
(OR threshold in the software)



Laser controls

More information
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Controls in the Laser tab of the Cytometer window are used to
manually set the (laser) delay, area scaling, and window extension
values.

These parameters are set by BD Biosciences service personnel
during instrument installation and performance check and are
updated each time you run a performance check.

If needed, see Optimizing laser delay (page 167) for instructions on
manually adjusting laser delay settings. Do not otherwise change
the settings in the Laser tab unless instructed to do so by

BD Biosciences. Changing the settings affects your data.

Cytometer - LSRFortessa (1)

| Mare Delay Aren Sesling
{Bhue 0,00 1,00
Viclat 0.00 ) 1.00
355 UV 0.00] 100
{Red 60,00 1,00
Whindow Extension: | 10,00 g[ﬂ

FSC ares Scaing: | 100 (5[

BD Defauks

Cybometer Cormscbed

* Running a performance check (page 68)

e  Optimizing laser delay (page 167)
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Troubleshooting

This chapter covers the following topics:

e Cytometer troubleshooting (page 118)
e Electronics troubleshooting (page 127)
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Cytometer troubleshooting

Introduction

Droplets are visible
on the SIP

This topic describes possible problems and recommended solutions
for special order BD LSRFortessa X-20 cell analyzer issues.

Possible causes

Recommended solutions

Worn O-ring in the retainer

Replace the O-ring. See Changing the
sample tube O-ring (page 60).

Outer sleeve is not seated in
the retainer

Loosen the retainer.

2. Push the outer sleeve up into the
retainer until seated.

3. Tighten the retainer.

Outer sleeve is not on the
sample injection tube

Replace the outer sleeve.

1. Loosen the retainer.

2. Slide the outer sleeve over the
sample injection tube until it is
seated.

3. Tighten the retainer.

Waste line is pinched,
preventing proper aspiration

Check the waste line.

Waste tank is full

Empty the waste tank.

Droplet containment vacuum
is not functioning

Call your BD service representative.

The HTS acquisition control
switch is in plate mode

Change the acquisition control switch
to tube mode. See the BD High
Throughput Sampler User’s Guide for
more information.




Sample tube not
fitting on SIP

Rapid sample
aspiration

No events in
acquisition display
and RUN button is
green
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Possible causes

Recommended solutions

Sample tube other than
Falcon® tubes used

Use Falcon 12 x 75-mm sample tubes.
See Equipment (page 178).

Worn Bal seal

Replace the Bal seal. See Changing the
Bal seal (page 58).

Sample tube is cracked

Transfer contents to a new tube.

Possible causes

Recommended solutions

Support arm is to the side

Place the support arm under the
sample tube.

Droplet containment module
is failing

Try the solutions in Droplets are
visible on the SIP (page 118). If the
issue is not resolved, call your BD
service representative.

Possible causes

Recommended solutions

Threshold is not set to the

correct parameter (usually
FSC)

Set the threshold to the correct
parameter for your application.

Threshold level is too high

Lower the threshold level.

PMT voltage for threshold
parameter is set too low

Set the PMT voltage higher for the
threshold parameter.

Gating issue

See the BD FACSDiva Software
Reference Manual for information on
setting gates.

Air in the sheath filter

Purge the filter. See Removing air
bubbles (page 33).

Air bubble or debris in the

flow cell

Prime the fluidics system. See Priming
the fluidics (page 39).
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Possible causes

Recommended solutions

No sample in the tube

Verify that sample remains in the tube
and if necessary, add sample to the
tube or install a new sample tube.

Sample is not mixed properly

Mix the sample to suspend the cells.

Waste tank is full

Empty the waste tank.

PMT voltages set too low or
too high for display
parameter

Adjust the PMT voltages.

Too few events are displayed

Increase the number of events to
display.

Sample injection tube is
clogged

Remove the sample tube to allow

backflushing.

If the event rate is still erratic, clean
the sample injection tube. See Cleaning
the fluidics (page 47).

Bal seal is worn

Replace the Bal seal. See Changing the
Bal seal (page 58).

Instrument is not warmed up

Wait 30 minutes for the instrument to
warm up.

Laser delay is set incorrectly

Adjust the laser delay settings. See
Manual settings (page 1635).

Laser is not functioning

Verify the malfunction by changing the
threshold to an alternative laser while
running the appropriate sample. If
unsuccessful, contact BD Biosciences.

Tube is cracked or misshapen

Replace the sample tube.




No events in
acquisition display
and RUN button is
orange
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Possible causes

Recommended solutions

RUN is not activated

Press the RUN button.

Sample tube is not installed
or is not properly seated

Install the sample tube correctly on the
SIP.

Waste container is
pressurized

Replace the waste air filter.

Caution! Pressurized contents
might spray. Use appropriate
cautionary measures.

1. Slowly loosen the waste tank cap
to relieve the pressure in the waste
tank.

2. Remove the waste vent filter by
rotating counter-clockwise.

3. Install a new waste vent filter.

Sample tube is cracked

Replace the sample tube.

Waste tubing line is not
connected to the waste cap

Connect the waste tubing line to the
waste cap.

Sheath container is not
pressurized

e Ensure that the sheath container lid
and all connectors are securely
seated.

e Inspect the sheath container O-ring
inside the lid and replace it if
necessary.

Bal seal is worn

Replace the Bal seal. See Changing the
Bal seal (page 58).

Air leak at sheath container

Ensure that the sheath container lid
and all connectors are securely seated.

Sheath container is empty

Fill the sheath container.

Air in sheath filter

Purge the filter. See Removing air
bubbles (page 33).




122 | BD LSRFortessa X-20 Cell Analyzer User’s Guide

No fluorescence
signal

No signal in red
laser channels

High event rate

Possible causes

Recommended solutions

Incorrect fluorochrome
assignment

Make sure that the cytometer
configuration in the software matches
the optical filters in the cytometer and
the configuration is as expected.

Wrong filter is installed

Make sure the appropriate filter is
installed for each fluorochrome. See
Changing optical filters and mirrors
(page 42).

Laser is not functioning

Call your BD service representative.

Possible causes

Recommended solutions

Incorrect laser delays due to
a change in the sheath tank
fluid level

e Check the fluid level in the sheath
tank and refill if necessary.

e Adjust the laser delay settings. See
Manual settings (page 165).

Possible causes

Recommended solutions

Air bubbles in the sheath
filter or flow cell

Remove the air bubbles. See Removing
air bubbles (page 33).

Threshold level is too low

Increase the threshold level. See the
BD FACSDiva Software Reference
Manual for instructions.

PMT voltage for the
threshold parameter is set
too high

Set the PMT voltage lower for the
threshold parameter. See the

BD FACSDiva Software Reference
Manual for instructions.

Sample is too concentrated

Dilute the sample.

Sample flow rate is set to
HIGH

Set the sample flow rate to MED or
LOW.




Low event rate

Erratic event rate
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Possible causes

Recommended solutions

Threshold level is too high

Lower the threshold level. See the
BD FACSDiva Software Reference
Manual for instructions.

Air bubble or debris in the
flow cell

Prime the fluidics system. See Priming
the fluidics (page 39).

PMT voltage for the
threshold parameter is set
too low

Set the PMT voltage higher for the
threshold parameter. See the

BD FACSDiva Software Reference
Manual for instructions.

Sample is not adequately
mixed

Mix the sample to suspend the cells.

Sample is too diluted

Concentrate the sample. If the flow
rate setting is not critical to the
application, set the flow rate switch to
MED or HI.

Sample injection tube is
clogged

Remove the sample tube to allow
backflushing.

If the event rate is still erratic, clean
the sample injection tube. See Cleaning
the fluidics (page 47).

Possible causes

Recommended solutions

Sample tube is cracked

Replace the sample tube.

Air bubble or debris in the
flow cell

Prime the fluidics system. See Priming
the fluidics (page 39).

Bal seal is worn

Replace the Bal seal. See Changing the
Bal seal (page 58).
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Distorted scatter
parameters

Excessive amount
of debris in display

Possible causes

Recommended solutions

Sample injection tube is
clogged

Remove the sample tube to allow

backflushing.

If the event rate is still erratic, clean
the sample injection tube. See Cleaning
the fluidics (page 47).

Contaminated sample

Prepare the specimen again. Ensure
that the tube is clean.

Sheath filter is dirty

Replace the filter. See Changing the
sheath filter (page 56).

Possible causes

Recommended solutions

Cytometer settings are
improperly adjusted

Optimize the scatter parameters. See
the BD FACSDiva Software Reference
Manual for instructions.

Air bubble in the sheath filter

or flow cell

Purge the air from the filter. See
Removing air bubbles (page 33).

Flow cell is dirty

Flush the system. See Flushing the
system (page 50).

Air leak at sheath container

Ensure that the sheath container lid is
tight and all connectors are secure.

Hypertonic buffers or
fixative

Replace the buffers or fixative.

Possible causes

Recommended solutions

Threshold level is too low

Increase the threshold level.

Sheath filter is dirty

Replace the filter. See Changing the
sheath filter (page 56).

Flow cell is dirty

Flush the system. See Flushing the
system (page 50).




High CV or poor QC
results
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Possible causes

Recommended solutions

Dead cells or debris in the
sample

Examine the sample under a
microscope.

Sample is contaminated

Re-stain the sample. Ensure that the
tube is clean.

Stock sheath fluid is

contaminated

Rinse the sheath container with DI
water, then fill the container with
sheath fluid from another (or new lot)
bulk container.

Possible causes

Recommended solutions

Air bubble in sheath filter or
flow cell

e DPurge the filter. See Removing air
bubbles (page 33).

e Prime the fluidics system. See
Priming the fluidics (page 39).

Sample flow rate is set too

high

Set the sample flow rate lower.

Air leak at sheath container

Ensure that the sheath container lid is
tight and all connectors are secure.

Flow cell is dirty

Flush the system. See Flushing the
system (page 50).

The dichroic mirrors are
installed backwards

Remove the dichroic mirrors, reverse
them, and replace them in the optical
holder.
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Possible causes

Recommended solutions

Waste tank is pressurized

Replace the waste vent filter.

Caution! Pressurized contents
might spray. Use appropriate
cautionary measures.

1. Slowly loosen the waste tank cap
to relieve the pressure in the waste
tank.

2. Remove the waste vent filter by
rotating counter-clockwise.

3. Install a new waste vent filter.

Poor sample preparation

Repeat sample preparation.

Sample was not diluted in the
same fluid as the sheath fluid

Dilute the sample in the same fluid as
you are using for sheath.

Optical filters are incorrect

Check the configuration and insert the
correct filters.

Old or contaminated QC
particles

Make new QC samples and perform
the quality control procedure again.

Instrument is not warmed up

Wait 30 minutes for the instrument to
warm up.

Laser is not functioning

Contact BD Biosciences.

Optical alignment problem

Contact BD Biosciences.

Optical filters are incorrect

Check the configuration and insert the
correct filters.
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Electronics troubleshooting

Introduction This topic describes possible problems and recommended solutions
for BD LSRFortessa X-20 electronic issues.

“Cytometer

Disconnected” in Possible causes Recommended solutions

cytometer window . .
Cytometer power is off Turn on the cytometer main power.
Communication failure 1. In BD FACSDiva software, select
between workstation and Cytometer > Connect.
cytometer 2. If connecting does not work,

restart the cytometer. Turn the
cytometer off, wait 1 minute, and
turn on the cytometer main power.

3. If connecting still does not work,
contact BD Biosciences.
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Detector array configurations

This chapter covers the following topics:

*  Fluorescence spectra (page 130)

* About configuration maps (page 132)

e About the base configuration (page 133)

e Base configuration polygon maps (page 137)

® Special order configurations (page 150)
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Fluorescence spectra

Introduction

Designing
multicolor panels

This topic shows sample emission spectra from common
fluorochromes, as well as the more common laser excitation lines.
This information is useful for designing multicolor panels. An
interactive fluorescence viewer is also available at
bdbiosciences.com.

The special order BD LSRFortessa X-20 cell analyzer is designed
specifically for multicolor research. There are many options for
dyes, reagents, and system configurations.

When choosing a configuration or panel, it is important to
remember that final results depend on the excitation and emission
spectra of the individual dye, the number of fluorescently labeled
binding sites on the cell, as well as spectral overlap and spillover to
other PMTs. For more information about designing multicolor
panels, see Selecting Reagents for Multicolor Flow Cytometry
(Part No. 23-9538-02).


http://www.bdbiosciences.com
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Example laser and
dye interactions

The following figure shows the emission spectra of some common
dyes, based on laser excitation. In many cases, a given dye can be

excited by multiple laser wavelengths, yielding different emission
intensities.
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About configuration maps

Introduction

Filter and mirror
arrangement

This topic describes the filter and mirror arrangements in the
detector arrays.

The filters are arranged in the detector array to steer progressively
shorter wavelengths of light to the next PMT in the array. The
longest wavelength should be in the A position and the shortest
wavelength should be in the last position used.

There should not be any empty slots for any laser being used.
Always use a blank optic holder.

If a slot is filled with a filter or mirror, an identifying number
appears in that position on the configuration map. If a slot is filled
with a blank optic holder, that position on the configuration map is
unlabeled.
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About the base configuration

Introduction This section describes the base configuration options available
with the special order BD LSRFortessa X-20 cell analyzer.

Nine available The base configuration for a BD LSRFortessa X-20 cell analyzer
configurations supports detectors, filters, and mirrors for up to five lasers to
provide up to 18-color detection.

Number
of lasers | Colors | Lasers See section...
1 4 4 Blue Four-color blue laser configuration (page 139)
2 6 4 Blue Four-color blue laser configuration (page 139)
2 Red Two-color red laser configuration (page 142)
7 5 Blue Five-color blue laser configuration (page 140)
2 NUV Two-color NUV laser configuration (page 148)
8 5 Blue Five-color blue laser configuration (page 140)

3 Red Three-color red laser configuration (page 143)
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Number
of lasers | Colors | Lasers See section...
3 8 4 Blue Four-color blue laser configuration (page 139)
2 Red Two-color red laser configuration (page 142)
2 NUV Two-color NUV laser configuration (page 148)
8 4 Blue Four-color blue laser configuration (page 139)
2 Red Two-color red laser configuration (page 142)
2 Violet Two-color violet laser configuration (page 145)
10 5 Blue Five-color blue laser configuration (page 140)
3 Red Three-color red laser configuration (page 143)
2 NUV Two-color NUV laser configuration (page 148)
11 5 Blue Five-color blue laser configuration (page 140)
3 Red Three-color red laser configuration (page 143)
3 Violet Three-color violet laser configuration (page 146)
14 5 Blue Five-color blue laser configuration (page 140)
3 Red Three-color red laser configuration (page 143)
6 Violet Six-color violet laser configuration (page 147)
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Number
of lasers | Colors | Lasers See section...
4 10 4 Blue Four-color blue laser configuration (page 139)

2 Red Two-color red laser configuration (page 142)
2 Violet Two-color violet laser configuration (page 145)
2 NUV Two-color NUV laser configuration (page 148)

12 2 Blue Two-color blue laser configuration (page 138)
3 Red Three-color red laser configuration (page 143)
2 NUV Two-color NUV laser configuration (page 148)
5 Yellow-green | Five-color yellow-green laser configuration (page 149)

13 5 Blue Five-color blue laser configuration (page 140)
3 Red Three-color red laser configuration (page 143)
3 Violet Three-color violet laser configuration (page 146)
2 NUV Two-color NUV laser configuration (page 148)

16 5 Blue Five-color blue laser configuration (page 140)
3 Red Three-color red laser configuration (page 143)
6 Violet Six-color violet laser configuration (page 147)
2 NUV Two-color NUV laser configuration (page 148)

18 6 Blue Six-color blue laser configuration (page 141)
4 Red Four-color red laser configuration (page 144)
6 Violet Six-color violet laser configuration (page 147)
2 NUV Two-color NUV laser configuration (page 148)
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Base configuration The special order BD LSRFortessa X-20 cell analyzer has one base
configuration at installation. Custom configurations can be added
for different applications. The following image shows a default
base cytometer configuration.

Cytometer Configuration

Cytometer: BDLSR Fortessa Current Configuration:  6-Blue 4-Red 6-violet 2-NUY
Cytometer Name: LSRFortessa

Serial Number: 1 Base Configuration: 6-Blue 4-Red 6-Violet 2-NUV

Configurations {Pavametar; | Filters and Mirars |

6-Blue 4-Red 6-Violet 2-NUY
= |7 Base Configurations

6] 4-Blue (8D defoulty Blue Laser Red Laser violet Laser NUY Laser
&) 4-Blue 2-Red (BD default) (4?:55'2:"1) (640nm) (405nm) (375nm)

€] 5-Blue 3-Red (BD defaulty
€] 5-Biue 2-U¥ (BD default)
€] 4-Blue 2-Red 2-Violet (BD defaulty

€] 5-Blue 3-Red 3-Violet (BD defaulty

€] 5-Blue 3-Red 6-violet (BD defaulty

] 4-Blue 2-Red 2-U¥ (BD default)

€] 5-Blue 3-Red 2-U¥ (BD default)

€] 4-Blue 2-Red 2-Violet 2-U¥ (BD default)
€] 5-Blue 3-Red 3-Violet 2-U¥ (BD default)
€] 5-Blue 3-Red 6-iolet 2-U¥ (BD default)
€] 6-Blue 4-Red 6-iolet 2-U¥ (BD default)
@ #-20 C-Charlie SESVZNUYIR

@ #-20 C-Charlie S8 5 2WUY 3R
@ #-20 C-Charlie 58 2V 2HUV 3R DM
5 £-8lue 4-Rex ]

=& C3T Folder
@]/ ST _%-20 C-Charlie gBVZNLIVR. 02/14/13 ..
8] 57 %20 C-charlie 58 5% 2 R 0211913
@) 5T %20 C-hrli 58 2 2NUV 3R DM 0211313 ..
@] #-20 ¢-Charlie 58 28V 2LV 3R DM 0212113
@ #-20 C-Charlie 58 Z8Y 421 & 500 ZNUY 3R DM 02{28(13 ...

Al |Blus | Red | violet | oy |

Window Extension (us): 10,00 Comments:
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Upgrade options The special order BD LSRFortessa X-20 cell analyzer optical
configuration can be upgraded to use different special order
wavelength options and a variety of detectors. See Special order
configurations (page 150) for a list of some common special order
laser/detector combinations available through the BD special order
research program. Many other special order configurations and
options are also available.

More information e  Verifying the configuration and user preferences (page 66)

® Base configuration polygon maps (page 137)

Base configuration polygon maps

Introduction This section describes how filters and mirrors are arranged for
standard polygon configurations.

About the maps The tables in this section show the detectors, filters, and mirrors
used in each configuration, and recommended fluorochromes for
each detector. The word “blank” indicates that a blank optical
holder should be used instead of an optic holder containing a
mirror or filter. A dash (—) indicates that no slot exists for a mirror
in that PMT position.
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Two-color blue The following map shows the two-color configuration for the
laser configuration 488-nm blue laser.

PMT LP mirror BP filter | Fluorochromes
A 640 695/40 PerCP-CyS5.5
505 525/50 FITC
C Blank 488/10 SSC
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Four-color blue The following map shows the four-color configuration for the

laser configuration 488-nm blue laser.

PMT | LP mirror BP filter | Fluorochromes
A 750 780/60 PE-Cy™7
B 685 695/40 PerCP-CyS5.5, PE-Cy™S5, PerCP, PI
C 550 575126 PE
D 505 530/30 FITC, Alexa Fluor™ 488
E Blank 488/10 SSC




140 | BD LSRFortessa X-20 Cell Analyzer User’s Guide

Five-color blue The following map shows the five-color configuration for the
laser configuration 488-nm blue laser.

PMT LP mirror BP filter Fluorochromes
A 750 780/60 PE-Cy7
685 695/40 PerCP-CyS5.5
C 600 610/20 BD Horizon™ PE-CF594,
PE-Texas Red®
D 550 575126 PE
505 530/30 FITC, Alexa Fluor™ 488
F Blank 488/10 SSC




Six-color blue laser
configuration

Chapter 9: Detector array configurations

The following map shows the six-color configuration for the

488-nm blue laser.

PMT LP mirror BP filter | Fluorochromes
A 750 780/60 PE-Cy7
B 685 695/40 PerCP-CyS.5
C 655 670/30 PE-Cy5
D 600 610/20 PE-CF594, PE-Texas Red®
E 550 575126 PE
F 505 530/30 FITC, Alexa Fluor™ 488
G Blank 488/10 SSC
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Two-color red laser The following map shows the two-color configuration for the
640-nm red laser.

configuration

PMT LP mirror BP filter Fluorochromes
A 750 780/60 APC-Cy7, APC-H7
B Blank 670/14 APC




Three-color red
laser configuration
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The following map shows the three-color configuration for the
640-nm red laser.

PMT LP mirror BP filter Fluorochromes
A 750 780/60 APC-Cy7, APC-H7
710 730/45 Alexa Fluor™ 700
C — 670/14 APC
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Four-color red laser The following map shows the four-color configuration for the

configuration 640-nm red laser.
PMT LP mirror BP filter Fluorochromes
A 750 780/60 APC-Cy7, APC-H7
B 710 730/45 Alexa Fluor™ 700
C 675 685/35 Alexa Fluor™ 680
D — 670/14 APC
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Two-color violet The following map shows the two-color configuration for the

laser configuration 405-nm violet laser.

PMT

LP mirror

BP filter

Fluorochromes

A

475

525/50

AmCyan, Qdot® 525,

BD Horizon™ V500-C,

BD Horizon™ Brilliant Violet™
BVS510

Blank

450/50

Pacific Blue™, BD Horizon™ V450,
Marina Blue®, Alexa Fluor™ 405,
BD Horizon™ Brilliant Violet™
BV421
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Three-color violet  The following map shows the three-color configuration for the
laser configuration 405-nm violet laser.

PMT | LP mirror | BP filter | Fluorochromes

A 595 610/20 Qdot® 605, BD Horizon™
Brilliant Violet™ BV605

B 475 525/50 | AmCyan, V500-C, BV510,
Qdot® 525
C — 450/50 Pacific Blue™, V450, BV421,

Marina Blue®, Alexa Fluor™ 405
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Six-color violet The following map shows the six-color configuration for the
laser configuration 405-nm violet laser.

PMT | LP mirror | BP filter | Fluorochromes

A 630 655/8 Qdot® 655

B 595 610/20 | BV605, Qdot® 605

C 575 585/15 | Qdot® 585

D 545 560/20 | Qdot® 565

E 475 525/50 | AmCyan, V500-C, BV510, Qdot® 525
F Blank 450/50 | Pacific Blue™, V450, BV421,

Marina Blue®, Alexa Fluor™ 405
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Two-color NUV The following map shows the two-color configuration for the
laser configuration 375-nm near-UV (NUV) laser.

PMT LP mirror BP filter | Fluorochromes
A 505 530/30 Indo-1 (Blue)
B Blank 450/50 | Indo-1 (Violet), DAPI,
Alexa Fluor™ 350




Five-color yellow-
green laser
configuration

More information
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The following map shows the five-color configuration for the
561-nm yellow-green laser.

PMT LP mirror BP filter Fluorochromes
A 750 780/60 PE-Cy7
B 685 710/50 PerCP-CyS5.5
C 635 670/30 PE-Cy5
D 600 610/20 PE-CF594, PE-Texas Red®
E Blank 586/15 PE

About the base configuration (page 133)

Special order configurations (page 150)
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Special order configurations

Introduction

Available options

BP filters used with
CS&T

Blue 488 nm (20-
100 mW)

This topic describes some of the more common configurations
available through the special order research program.

The special order BD LSRFortessa X-20 cell analyzer can be
configured with up to 5 lasers choosing from 11 different special
order wavelength options and a variety of detectors. This section
shows some of the common special order laser/detector
combinations. Contact your local BD Biosciences sales
representative for information about other configurations.

Not all combinations of special order BP filters and lasers are
normalized to CS&T settings. In this case, CS&T will generate Qr
and Br numbers that are not comparable from instrument to
instrument. Care should be taken when interpreting the CS&T
reported Qr values on special order BD LSRFortessa X-20
instruments. Please see the latest published filter guides available
on our website (bdbiosciences.com) for more information.

The fluorochromes listed in the following table can be used with
this laser wavelength for cell surface markers, live/dead
discrimination, and cell cycle applications. See Common blue laser
configurations (page 155) for common polygon configuration
maps.

Fluorochromes BP filters
SSC 488/10
FITC, Alexa Fluor™ 488 530/30
PE 575125
575126
576126
585/42
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Fluorochromes BP filters
PE-CF594, PE-Texas Red®, PI 605/12
610/20
616/23
PE-Cy5 660/20
670/30
PerCP, PerCP-CyS.5, PE-CyS5.5 670/14
675/20
695/40
710/50
PE-Cy7 780/60
Red 640 nm The fluorochromes listed in the following table can be used with
(40 mWw) this laser wavelength for the cell surface marker application. See

Common red laser configurations (page 157) for two common
polygon configuration maps.

Fluorochromes BP filters
APC, Alexa Fluor™ 647 670/30
Alexa Fluor™ 680 685/35
Alexa Fluor™ 700 710/50
710/20
712/21
730/45
APC-Cy7, APC-H7 780/60
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Violet 405 nm The fluorochromes listed in the following table can be used with

(20-100 mW) this laser wavelength for cell surface marker, live/dead
discrimination, and cell cycle applications. See Common violet
laser configurations (page 158) for common polygon configuration

maps.
Fluorochromes BP filters
V450, BV421, Pacific Blue™ 450/50
450/40
450/20
440/40
AmCyan, Alexa Fluor™ 430, V500-C, 510/50
BV510, DAPI 525/50
Qdot® 525 NA
Qdot® 545 NA
Qdot® 565 560/20
560/40
Qdot® 585 585/15
585/42
BV60S, Qdot® 605 605/12
605/40
610/20
Qdot® 655 655/8
670/30
BD Horizon™ Brilliant Violet™ BV711, 710/50
Qdot® 700, Qdot® 705 712/20
Qdot® 800 780/60
800/30

Note: If a 561-nm yellow-green laser is configured, a 561 notch
filter is required for Qdot® 565 and Qdot® 585.

Note: The 800/30 bandpass filter is a special order research
program filter.
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UV 355 nm (20- The fluorochromes listed in the following table can be used with

100 mW) this laser wavelength for the cell cycle application with the DAPI
and Hoechst fluorochromes. The wavelength is used for the Ca*?
flux application with both Indo-1 fluorochromes. See Common
UV laser configurations (page 160) for two common polygon
configuration maps.

Fluorochromes BP filters
DAPI, Hoechst 440/40
450/20
450/40
450/50
Indo-1 (Ca Bound) 450/50
Indo-1 (Ca unbound) 530/30

Yellow-green 561  The fluorochromes listed in the following table can be used with

nm (50 mW) this laser wavelength for cell surface marker and fluorescent
protein applications. See Common yellow-green laser
configuration (page 162) for a common polygon configuration

map.
Fluorochromes BP filters
PE, DsRed 586/15
PE-CF594, PE-Texas Red®, 610/20
mCherry
PE-Cy$ 660/20
670/30
PE-CyS5.5 710/50
PE-Cy7 780/60
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Green 532 nm The fluorochromes listed in the following table can be used with

(150 mw) this laser wavelength for the cell surface markers application. See
Common green laser configuration (page 163) for a common
polygon configuration map.

Fluorochromes BP filters
PE 575125
PE-CF594, PE-Texas Red® 610/20
PE-Cy5 660/20
670/30
PE-CyS5.5 695/40
710/50
PE-Cy7 780/60
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Common blue laser The following maps show two common configurations for the
configurations 488-nm blue laser.

PE-CF594 PE-Cy7
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SSC P

erCP-Cy5.5

Note: With the 488-nm blue laser, FITC requires a 525/50 notch
filter if the cytometer also uses a 532-nm laser.
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Common red laser  The following maps show two common configurations for the
configurations 640-nm red laser.
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Common violet The following maps show two common configurations for the
laser 405-nm violet laser.
configurations
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Qdot® 655 Qdot® 800

Note: If a 561-nm yellow-green laser is configured, a 561 notch
filter is required for Qdot® 565 and Qdot® 585.
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Common UV laser  The following maps show two common configurations for the
configurations 355-nm UV laser.

=S

nd0-1

(blue)
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Indo-1 (violet)
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Common yellow- The following map shows a common configuration for the 561-nm
green laser yellow-green laser.
configuration

PE-CF594

Note: When you use a PE conjugate with a 561-nm laser, you must
replace the 585/42 bandpass filter (BP) with a 582/15 BP,
regardless of which laser (blue, green, or yellow-green) is exciting
the PE fluorochromes.
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Common green The following map shows a common configuration for the 532-nm
laser configuration green laser.

PE-CF594
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Manual settings

This chapter covers the following topics:

e About laser delay (page 166)
e  Optimizing laser delay (page 167)
*  Adjusting area scaling (page 169)
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About laser delay

Introduction

About laser signal
delay

This topic describes how to manually set the laser delay if you are
not using CS&T for cytometer setup and tracking.

Sample interrogation takes place within the cuvette flow cell. Laser
light is directed through a series of prisms that focus multiple lasers
on the event stream at different positions. This allows optimal
detection of fluorescent signals from each laser with minimal cross-
contamination from the other beams.

For example, in a BD LSRFortessa X-20 four-laser system, the blue
laser intercepts the stream first, followed by the violet, UV, and red
lasers. Because the laser signals are spatially separated, there is a
slight delay between the detection of each laser’s signal.

Event intercepts yellow-green laser* ’ \
" Event intercepts red laser Yellow-green
= Event intercepts UV laser r \

Event intercepts violet laser Red

Event intercepts blue laser {\

uv

‘ I Violet
{\— Blue

Time——>

*The yellow-green laser is only available through the BD special order research program.

The laser delay setting in BD FACSDiva software is used to re-align
the signals so they can be measured and displayed on the same time
scale. Signals are aligned with respect to the blue laser, so the blue
laser will have a 0 delay value, and the red laser will have the
longest delay.
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Optimizing laser delay

Introduction This topic describes how to optimize the laser delay using
BD FACSDiva software.

Before you begin  To optimize the delay for a given laser, you must acquire events
from a sample with a fluorescence signal excited by that laser.
Follow the procedures in Recording and analyzing data (page 85),
for sample optimization and acquiring data.

Procedure To optimize laser delay:

1. While acquiring data from your sample, create a histogram to
show the fluorescence signal excited by the laser for which the
delay is to be optimized.

2. In the Acquisition Dashboard, set the Events to Display to 500
events.

3. Click the Laser tab in the Cytometer window.

Window extension and laser delay values are displayed in
microseconds (ps).

ES Cytometer - 754100007 (LSRFortessa) (1)

Harme Delary
(Ethum 0.75
{Red as7
[viclet 0.55
L 0.52

Window Extension: (10.00 3|

F5CAreascaling: | 0.74 S

BO Deffaults
Cytometer Conmeched
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4. Set the Window Extension value to 0 ps.

5. Set an initial laser delay value only for the laser you are
optimizing,.
e If you are optimizing the violet laser, set its delay to 40 ps.
e If you are optimizing the UV laser, set its delay to 75 ps.
¢ If you are optimizing the red laser, set its delay to 110 ps.

6. While observing the positive events on the histogram, adjust
the laser delay in 1-ps increments. You might need to adjust
the delay above or below the initial setting.

Choose the setting that moves the events farthest to the right
(highest fluorescence intensity).

7. Draw an interval gate on the histogram for the positive events.

8. Create a statistics view to display the mean fluorescence
intensity (MFI) of the gated population.

9. While observing the MFI for the gated population, adjust the
laser delay in 0.1-ps increments within a range of 2.0 ps of the
setting obtained in step 6.

Preserve the setting that maximizes the fluorescence intensity.

10. Reset the Window Extension to 10 ps.
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Adjusting area scaling

Introduction This topic describes how to manually adjust the area scaling on
your cytometer if necessary for your application. The area scaling
is automatically set in CS&T. Depending on the size of your target
particle, you might need to adjust the area scaling manually. Larger
particles are more likely to require an area scaling adjustment.

About area scaling The area of a pulse is calculated by BD FACSDiva using measured
height and width measurements. It is sometimes important to
verify that the area calculation and the height measurement are
equivalent by adjusting the factor applied to the area. The required
area scaling factor changes based on sheath pressure and particle
size.

About this example The following example describes how to adjust area scaling for an
experiment which uses only the 488-nm laser and the 640-nm
laser. You must adjust area scaling for all lasers used in your
experiment. To adjust the other lasers, add a parameter and the
corresponding plots from that laser to the procedure.

Procedure To adjust area scaling:
1. Open an existing experiment, Oor create a new experiment in
the Browser.

2. Create a new specimen by clicking the New Specimen button
on the Browser toolbar.
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3.

In the Inspector, click the Parameters tab and select the H
checkbox to select height for each parameter.

i:g'mnml&r - Z5A100004 Pilot #4 (LSRFortessa) (1)

| Status | Parametars | Theeshold | Laser | Compensation | Ratiol
Porameter Wotage | Log | A | H | W ||
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* Aleta Fhar 405 416 ]
= Amyan fre6 O
* Qdot 555 49 F | O
- Gudot 555 36 ]
* ok G053 :565 |
- qudot 655 = O
« Inda 1 Fiokt 336 (ml|
* tndo 1 Blue 545 O |~
| s [ e
ICYt-omtcrl.'mM

On the global worksheet, create the following plots and
histograms:

e FSC vs SSC dot plot

e FSC-H and FSC-A histogram

e FITC-H and FITC-A histogram

e APC-H and APC-A histogram

Create a P1 gate in the FSC vs SSC plot, and show only the P1
population in all histograms.
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6. Create three statistic views showing the following:

FSC-H and FSC-A means for P1

FITC-H and FITC-A means for P1

APC-H and APC-A means for P1

Your worksheet should look similar to the following figure.
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7. Expand the new specimen, then set the current tube pointer to
tube_001.
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8. Install the FITC-positive control tube onto the loading port
and click Load in the Acquisition Dashboard.

9. Adjust the FSC and SSC voltages to place the particles on
scale.

Specimen_001-Tubhe_001

¥

{¢ 1,000
mo 2

S5C-H

1qnl III.I I:I

il

|||I|||||||||||||||||||||||
50 100 150 200 250
FSr-H [z 1,0007

10. Adjust the P1 gate around the population of interest.
11. Adjust the FSC area scaling.

a. Click the Laser Tab in the Cytometer window.

b. Adjust the FSC area scaling factor until the FSC-A signal
matches the FSC-H signal:

¢ Increase the area scaling factor if the FSC-A signal is
lower than FSC-H.
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e Decrease the area scaling factor if the FSC-A signal is
higher than FSC-H.

Cytometer - 254100002 (LSRFartessa) (1)

Status | Parameters | Threshold |{Laser | Compensation | Ratia|

i Delay frea Scaling |
Elue .00 0.75
Red 114.48 .56
ikt 33,11 0,88
T 75.17 0.48

Window Extenslon: [ 10.00 =
(_F5C Area Scaling: 0.59 5

I Cybometer Conneched

c. View the result of your change in the histograms and
statistics views.

12. Adjust the blue laser area scaling factor until the FITC-A signal
matches the FITC-H signal, if needed.

13. Unload the FITC-positive control tube, then load the APC-
positive control tube.
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14. Adjust the red laser area scaling factor until the APC-A signal
matches the APC-H signal, if needed.

Specimen_001-Tube_001

Count

140 o 0
FSC-H (x 1.000)

Specimen 001-Tube 001
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FSC-A FSC-H
Population Mean Kean |

Wri 68,989 68,339
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Supplies and consumables

This chapter covers the following topics:

® Ordering information (page 176)
e Beads (page 176)

e Reagents (page 177)

¢ Equipment (page 178)
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Ordering information

To order spare parts and consumables from BD Biosciences:

e Within the US, call (877) 232-8995.

®  Qutside the US, contact your local BD Biosciences customer
support representative.

Worldwide contact information can be found at
bdbiosciences.com.

Beads

Introduction This topic lists the QC and CS&T beads available.

QC particles
Particle Laser Supplier Catalog No.
SPHERO™ Rainbow Calibration All BD Biosciences 559123

Particles (8 peaks)

SPHERO Ultra Rainbow All Spherotech, Inc. URFP-30-2
Fluorescent Particles (single peak)

BD DNA QC Particles Blue (488 nm) BD Biosciences 349523
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CS&T beads
Bead Laser Supplier Catalog No.
BD FACSDiva e UV (355 nmand 375 nm) | BD Biosciences | ® 655050
CS&T research e Violet (405 nm) (50 tests)
beads
e Blue (488 nm) e 655051
(150 tests)
e Red (640 nm)
e Yellow-green (561 nm)
e Green (532 nm)
Reagents
Reagent Supplier Catalog No.
BD FACSFlow sheath fluid BD Biosciences 342003
BD FACS™ sheath solution BD Biosciences 336524
with surfactant (recommended
for use with the HTS option)
Monoclonal antibodies BD Biosciences See the BD Biosciences

Product Catalog or the
BD Biosciences website
(bdbiosciences.com)

BD FACS™ lysing solution BD Biosciences 349202

BD Detergent Solution BD Biosciences 660585
Concentrate



http://www.bdbiosciences.com

178 | BD LSRFortessa X-20 Cell Analyzer User’s Guide

Reagent Supplier Catalog No.
BD FACSClean solution BD Biosciences 340345
Dyes and fluorochromes BD Biosciences, Life -
Technologies, or Sigma
Chlorine bleach Clorox® or other major -
(5% sodium hypochlorite) supplier (to ensure that the
bleach is at the correct
concentration and free of
particulate matter)
Equipment
Equipment item Supplier Catalog No.
Bal seal BD Biosciences 343509
O-ring, sample tube 343615
Sheath filter assembly 345734
Falcon polystyrene test tubes, 12 x 75-mm Corning 352008
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355-nm UV laser 153, 160

375-nm near-UV laser 148
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532-nm green laser 154, 163

561-nm yellow-green laser 153, 162
640-nm red laser 142-144, 151,157

A

acridine orange (AO) 47
air bubbles, removing 33
alarm
battery test 52
waste container 23
analysis
data 86
immunophenotyping 91
reusing 97
saving 97
antibodies 102
AO See acridine orange
application settings
applying 87
creating 76
area scaling 169
arm, tube support 21
aspiration (sample), rapid 119
assistance, technical 13

Bal seal
ordering 178
replacing 58
bandpass (BP) filters
detector array placement 25
theory 107
base configurations 137
battery
changing 53
test 52
BD Detergent Solution Concentrate 48
BD FACSClean solution 178
BD FACSDiva software See software
BD FACSFlow sheath fluid 177
BD FACSFlow solution 33
BD FACSFlow supply system 30, 49
BD High Throughput Sampler (HTS) 22
blank optical holders 41
bleach 46,178
blue 488-nm laser 139-141, 150, 155
BP See bandpass filters
bubbles, removing air 34
buttons
fluid control 20
sample flow rate control 19

C

calculating compensation 82
capacity, waste container 23
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cleaning solutions 46
compensation
calculating 82
control tubes 79
recording settings 80
theory 109
components
cytometer shown 17
sheath container shown 32
sheath filter shown 56
waste container shown 37
computer system, about 27
configuration
base 133
BD FACSDiva 66
containers
sheath 23, 31
waste 23, 36, 38
control panel, cytometer 18
controls
fluidics 18
single-stained 65, 86
conventions
safety symbols 11
creating
analysis objects 91
global worksheets 87
statistics view 91
CS&T particles 177
cuvette flow cell 166
CV, troubleshooting 125
cytometer 16
components shown 17
configuration 41, 66
disconnect error 127
door and drawer 42
setup 64
starting 30
troubleshooting 118

D

DAPI, cleaning after using 47
data

analyzing 86, 91

gating 91

recording 86, 88
debris, excessive 124
default configuration 133
delay, laser 166
detector arrays 24
detectors 26
dichroic mirrors

theory 108
digital data 16
digital electronics 114
Diva software See software
DNA, flow rate for analysis 101
droplet containment system 22

E

electronics

digital 114

laser controls 115

pulse 112

pulse measurements 113

threshold 114

troubleshooting 127
emission duration 112
event rate

erratic 123

high 122

low 123

zero 119,121
excessive debris 124
excitation wavelength 102
experiments

creating 72

immunophenotyping 87

sample optimization 72
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F

FACSFlow sheath fluid 177
FACSFlow solution 33
Falcon tubes 119
filters, optical
bandpass (BP) 25, 107
changing 42
dichroic See dichroic mirrors
longpass (LP) 104, 105
notch 105,156
shortpass (SP) 104, 106
theory 104
filters, sheath
attaching new 57
replacing 56
FITC and Stokes shift 103
fixed-alignment lasers 16
flow cell
draining 39
fluidics 100
flow rate control buttons 19
fluid control buttons
PRIME 20
RUN 20
STANDBY 20
fluidics
description 19, 100
flow rate control 19
flushing system 50
priming 39
removing air bubbles 34
run mode 20
sample injection port (SIP)
fluidics controls, cytometer 18
fluidics interconnect 35
fluorescence
defined 102

emission 112

21
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fluorescence signal, none 122
fluorochromes
compensation theory 109
emission spectra 103
measured 41
role in light emission 102
flushing the system 50
forward scatter (FSC) 102
FSC See forward scatter

G

gating data 91
global worksheets
analyzing data 91
creating 87
previewing data 86, 97
green 532-nm laser 154, 163

H

hazard symbol definitions 11

Help, accessing 12

High Throughput Sampler (HTS) 22
hydrodynamic focusing 100

immunophenotyping
analysis 91
experiment 87
hydrodynamic focusing 101

K
knob, SAMPLE FINE ADJ 19

L
laser delay
about 166
optimizing 167
lasers
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options 24

performance check 68

quality control (QC) particles 176
longpass (LP) filters

defined 104

theory 105
LP See longpass filters

M

maintenance
Bal seal 58
battery change 53
battery test 52
cytometer shutdown 49
sample tube O-ring 60
schedule 47
scheduled 50
sheath filter 56
system flush 50
waste management system 52
mirrors, dichroic longpass (LP) filter 25

N

notch filters 1035, 156

o

online Help 12
optic holder 41
optics
components 23
configuration 66, 67
dichroic mirrors 108
filters 25, 42,104
location 17
optimization, sample 64
ordering spare parts 176
O-ring
ordering 178
replacing 60

worn 118

P

particles 176,177

PerCP, Stokes shift 102
performance check 68, 69
photodiode 26

photomultiplier tubes (PMTs) 26
PMT See photomultiplier tubes

polygon
location 42
shown 25

population hierarchy 91

power switch 17,18

PRIME, fluid control button 20

priming fluidics system 39

propidium iodide (PI) 47

pulse
definition 112
measurements 113
processors 113

Q

quality control (QC)
particles 176
troubleshooting 125

R

recording
compensation settings 80
compensation tubes 79
data 86, 88
red 640-nm laser 142-144, 151, 157
removing air bubbles, filter 34

replacing
Bal seal 58
battery 53

optical filters 42
sample tube O-ring 60



sheath filter 56
waste air filter 55
reusing analyses 97
RUN
button orange 121
fluid control button 20

S

safety symbol definitions 11
safety symbols 11
sample
optimization 64
optimization experiment 72
optimization, single-stained
controls 63, 86
SAMPLE FINE ADJ knob 19
sample injection port (SIP)
components 21
hydrodynamic focusing 100
location 17
replacing Bal seal 58
replacing sample tube O-ring 60
sample tube
injection 21
not fitting 119
requirements 119
samples, running 88
saving analyses 97
scatter
light 102
parameter distortion 124
setup, cytometer 64
sheath
flow 100
pressure 100
sheath container
components shown 32
defined 23
depressurize 32
preparing 32
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sheath filter
components shown 56
ordering 178
removing air bubbles 33
replacing 56
sheath fluid 100
backflush 22
BD FACSFlow sheath fluid 177
shortpass (SP) filters 104, 106
side scatter (SSC) 102
signals, amplifying 26
SIP See sample injection port
software
cytometer control 10
version 27
spare parts, ordering 176
spillover 109
SSC See side scatter
STANDBY, fluid control button 20
starting cytometer 30
statistics views 91
Stokes shift 102
support, technical 13

T

technical assistance 13
testing battery 52
thiazole orange (TO) 47
threshold, defined 114
TO See thiazole orange
troubleshooting
cytometer 118
electronics 127
tubes
Falcon 119
requirements 119

U

user preferences 67
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UV 355-nm laser 153, 160

\')
violet 405-nm laser 145-147,152, 158

W

waste air filter
component shown 37
replacing 55

waste air vent filter
replacing 121

waste container 23
alarm 23
battery test 52
capacity 23
components shown 37
defined 23
emptying 36
pressurized 38, 121
replacing battery 53

window extension 167

workstation, about 27

Y
yellow-green 561-nm laser 153, 162
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